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COPYRIGHT INFORMATION 
FEDERAL COPYRIGHT LAW PROTECTS THIS SOFTWARE.  COPYING THE SOFTWARE FOR ANY REASON OTHER THAN 
TO MAKE A BACKUP IS A VIOLATION OF LAW.  INDIVIDUALS WHO MAKE UNAUTHORIZED COPIES MAY BE SUBJECT TO 
CIVIL AND CRIMINAL PENALTIES. 

Farm Trac Reference Guide (Version 12.0 and higher for Microsoft® Windows® Operating Systems) copyright© 2006 Farm 
Works Software®, a division of CTN Data, LLC  All rights reserved.  This document is the property of Farm Works Software. This 
document, as well as the software described in it, are furnished under license and may only be used in accordance with the terms 
of such license.  Except as permitted by such license, no part of this document may be reproduced, stored in a retrieval system, or 
transmitted by any means, electronic, mechanical, photocopying, recording, or otherwise, without written permission from Farm 
Works Software®.  All use, disclosure, and/or reproduction not specifically authorized by Farm Works Software® are prohibited. 

The information in this document is provided for reference only.  Although every precaution has been made to make the material 
herein as complete and accurate as possible, no warranty or fitness is implied, nor is any liability assumed for errors or omissions.  
The information provided is on an "as-is" basis.  Farm Works Software®, CTN Data, LLC, and the creators of this document shall 
have neither liability nor responsibility to any person or entity with respect to any loss or damages arising from the information 
contained herein or from the use of the CD or programs accompanying it.  Neither is any patent liability assumed with respect to 
the use of the information contained in this document. 

All terms mentioned in this document that are known to be trademarks, registered trademarks, or service marks have been 
appropriately capitalized.  Farm Works Software and CTN Data, LLC cannot attest to the accuracy of this information.  Use of a 
term in this document should not be regarded as affecting the validity of any trademark, registered trademark, or service mark.   

Farm Works Software, copyright© 1992-2006, is a registered trademark of CTN Data, LLC All rights reserved. 

SOFTWARE LICENSE AND LIMITED WARRANTY 
LICENSE: THIS SOFTWARE IS LICENSED UNDER THE FOLLOWING TERMS AND CONDITIONS, CONTINUING WITH THIS 
INSTALLATION INDICATES THAT YOU HAVE READ AND UNDERSTAND THIS SOFTWARE LICENSE AND LIMITED 
WARRANTY AND THAT YOU AGREE TO THESE TERMS AND CONDITIONS. IF YOU DO NOT AGREE TO ANY OF THEM, 
IMMEDIATELY RETURN THE PACKAGE FOR A REFUND. 

CTN Data, LLC (CTN) grants you a personal, non-exclusive, non-transferable license to use the enclosed software and user 
manual, ("Software") in accordance with the terms of this license. Title to and all rights in the Software remain with CTN. You 
agree to protect the Software against unauthorized use and disclosure. You will not copy the Software or any part thereof for any 
reason other than for backup purposes. Modifying of this Software in any way is strictly prohibited without the expressed written 
consent of CTN. You may not disclose, transfer, or otherwise make available the Software, in any form, to anyone without the prior 
written consent of CTN. 

TERM: This license is effective upon opening the package, and shall automatically terminate if you breach any of the terms and 
conditions herein. Upon such breach, you agree to destroy all copies of the Software and discontinue use thereof. 

Limited Warranty: The Software is sold "AS IS". You assume the entire risk as to the selection, result, and performance of the 
Software.  However, CTN warrants the magnetic diskette or CD on which the Software is recorded to be free from defect in 
material and workmanship under normal use for a period of ninety (90) days from the date of original purchase. Upon proof of 
purchase, CTN will replace a defective diskette or CD at no cost, (except for the cost of shipping, which will be paid by the 
Purchaser). YOUR SOLE AND EXCLUSIVE REMEDY IN THE EVENT OF DEFECT IS EXPRESSLY LIMITED TO 
REPLACEMENT OF THE DISKETTE OR CD, provided that the diskette or CD has not been abused in any way.   

THIS LIMITED WARRANTY CONSTITUTES YOUR SOLE AND EXCLUSIVE REMEDY AND THE SOLE AND EXCLUSIVE 
LIABILITY OF CTN AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING, BUT 
NOT LIMITED TO, ANY IMPLIED WARRANTY OR MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE AND 
ALL OTHER OBLIGATIONS OR LIABILITIES OF SELLER. IN NO CASE IS CTN LIABLE FOR SPECIAL, INCIDENTAL, 
CONSEQUENTIAL OR INDIRECT DAMAGES OR FOR LOST DATA. 

You many not sublicense, assign or transfer this license, the program or the related documentation, and any attempt to do so is 
void. This agreement is governed by the laws of the State of Indiana, where any claims arising hereunder shall be litigated. This 
agreement is for a license of intellectual property, and not for the sale of goods (even though some tangible items may be 
provided) and not governed by the Uniform Commercial Code. 

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE 
BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND 
EXCLUSIVE STATEMENT OF THE AGREEMENT BETWEEN US WHICH SUPERSEDES ANY PROPOSAL OR 
PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN US 
RELATING TO THE LICENSING OF SOFTWARE FROM CTN. 
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Welcome to Farm Trac       
Welcome to Farm Trac 
Farm Works Software® offers a complete suite of farm-management software 
modules to meet a wide range of needs for today’s producer. The software modules 
work seamlessly together, each adding features to the software suite. The programmers 
of Farm Works Software designed these programs to help you, the modern farmer, 
operate your farm efficiently and with greater profitability. The software does the hard 
work for you, so you don’t have to work as hard! 
 

Windows Vista Setup 
 
Farm Works will work with Windows Vista. However, you will need to configure the program 
after it is installed to make it work correctly. This can be accomplished in one of two ways. 
 
The first option is to set the program to run as 
an administrator. 
 

• Right click on the Farm Works icon and 
select Properties 

 
• Select the Compatibility tab. 

  
• Check the box to “Run this program as 

an administrator” 
 

• Press OK 
 
Note: When choosing this option, the computer 
will prompt you for permission to run this 
program when you start Farm Works. 
 
The second option is to disable user accounts on 
the computer. 
 

• Go to the Control Panel under the Start 
Menu. 

 
• Select “User Accounts” 
 
• Choose the option to “Turn User Control On/Off” 
 
• Click OK and restart the computer 
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Note: Microsoft recommends you keep this new security feature on. Be aware that you are 
removing a level of protection by disabling User Account Control alerts, and you will also be 
disabling Internet Explorer’s “protected mode.” 
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Registering Your Software 
 
Farm Works Office and Site Pro programs are easy to register with the Automatic Online 
Registration feature. All it takes is a computer connected to the internet and just a few clicks of 
your mouse and the software will register itself automatically. 
 
To use the Automatic Online Registration Feature: 
 

1. Verify your computer is connected to the internet via a broadband or dial-up connection. 
 
2. When you see the Farm Works Office registration dialog box, select the first option 

(Get Registered Immediately). 
 

 
 

3. Select Next and a message will appear indicating that the program has successfully 
completed the registration.
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Other Registration Options 
 
If you prefer, you can also use one of the other registration options: 
 
§ Print a Registration Form – Select the second option in the Farm Works Office 

Registration dialog box to print a registration form to return to your dealer. Your dealer 
will obtain the registration numbers for you. You can then select the fourth button to 
enter the registration numbers that your dealer provides you. 

 
§ Complete the Online Form – Select the third option button of the dialog box to obtain 

registration numbers using an online form. After completing the form, you will receive 
the registration numbers in an e-mail message. You can then select the fourth button to 
enter the registration numbers received in the e-mail. 

 
§ Enter Numbers You Previously Received – Select the fourth option button if you have 

already obtained registration numbers from your dealer or an e-mail. Select Next and 
enter the registration numbers in the Registration # boxes for each of the Farm Works 
Software programs you own. 

 

About Farm Works Software 

 
Farm Works Software® is located at CTN Data, LLC in Hamilton, Indiana. 

 
Farm Works Software® is the creator of software applications designed for today’s farmers, 
livestock managers and crop consultants. A division of CTN Data Service, Farm Works Software 
was founded in 1992 with the mission to create comprehensive farm-management programs that 
are simple to use. Farmers throughout the United States, Canada and Europe have come to trust 
Farm Works Software. They know they can rely on Farm Works Software to provide the 
software applications and hardware devices to get the job done right in the office and out in the 
field. Whatever your agricultural enterprise, you can count on Farm Works Software to work for 
you, so you don’t have to work as hard. 
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Farm Works Office Modules 
 
Farm Works Office includes Farm Trac, Farm Funds, Farm Site, Farm Stock, and Site Pro. 
Programmed for PCs and notebook or laptop computers running Microsoft Windows 2000 (or 
later), the office suite offers many new features and enhancements. 
 
§ Farm Trac – It’s the required record-keeping module of the Farm Works Office suite.  

Farm Trac keeps complete records of farming history, chemical usage, and costs for each 
of your fields.  The program exports work orders for future jobs that your workers can 
use in the Trac Mate program out on the farm. You now do not have to add maps before 
you record farming operations. It takes even less preparation to start using the program!  
If you want to keep maps made with previous versions of Farm Works Office, you can 
purchase the Farm Site mapping software. 

 
§ Farm Funds – A comprehensive farm-cost management program that takes the hassle 

out of keeping your finances in order. Farm Funds fully integrates with Farm Trac and 
Farm Stock.  The program maintains your books on both an accrual and cash basis, and 
gives you the assurance of knowing exactly how profitable each enterprise is on your 
farm.  It accurately maintains the records you need for tax purposes, and you edit 
previous transactions. Join the many farmers who are glad they let Farm Funds save them 
valuable time and money! 

 
§ Farm Stock – This livestock-management software helps any livestock manager stay 

organized.  Farm Stock makes it easy to keep track of the history for every animal, from 
birth to market.  The program keeps precise records of mating, births, genealogies, 
weights, and more, and it fully integrates with Farm Trac and Farm Funds.  The Farm 
Stock calendar reminds you of important events automatically, and the printable reports 
cover just about every aspect of your livestock operation.  You can even create your own 
customized reports! 

 
§ Farm Site – The mapping module of the Farm Works Office suite, Farm Site lets you 

import, create, edit and export GPS-referenced maps of your fields. You can generate 
soil-sampling grid maps and variable-rate-application prescription maps to export for use 
with the Site Mate and rate controllers out on the farm.  You can import field boundaries 
and soil-sampling jobs you completed in the field with Site Mate, and display yield or as-
applied data logged by various yield monitors and rate controllers.  Farm Site 
automatically draws field boundaries, grid maps, and contoured maps from yield data you 
import into the program.  It even clips soil-type maps to the boundaries of your fields in 
just a matter of seconds! 

 
§ Site Pro – Made for crop consultants, co-op managers, seed representatives and other 

professionals, Site Pro gives you every feature of Farm Trac and Farm Site for an 
unlimited number of your clients.  With Site Pro, all your clients’ maps and farming 
records are readily available.  The program keeps track of equipment usage and labor 
hours for workers, as well as supplies and chemical records!  You can also print or export 
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many equipment, supply, chemical and field-enterprise reports, as well as full-color 
maps, to give to your customers. 

 

Farm Works Mate Modules 
 
The Farm Works Mate software (Trac Mate, Site Mate, Guide Mate and Stock Mate) is designed 
for PDAs running Windows CE or Windows Mobile.  You can also use the programs on 
notebook or laptop computers running Windows 2000 (or later). The wide-screen Titan RT 
rugged tablet computer, available only from Farm Works Software is another popular option. 
 
§ Trac Mate – The perfect companion to Farm Trac, Trac Mate gathers complete 

information for all your farming jobs.  Trac Mate lets you enter field records for your 
supplies and equipment when it is convenient for you—while you’re in the field!  You 
can then import the farming records into Farm Trac when you return to the office. 

 
§ Site Mate – Site Mate lets you use a PDA or Titan RT, together with a GPS receiver, to 

create GPS-referenced maps in the field.  You can use Site Mate to create soil-sampling 
maps, or complete scouting jobs that record the locations of pests and problem areas, and 
import these maps into the Farm Site office program.  Site Mate also creates as-applied 
coverage maps.  If you buy Site Mate – VRA, you can display prescription maps made 
with the Farm Site office program. This will allow you to perform variable rate 
applications with a capable controller. 

 
§ Stock Mate – This handy program running on a pocket-sized PDA lets you record your 

livestock records while you are still in the barn or pasture.  When you get back to the 
office, you can conveniently import the livestock records into the Farm Stock program.  
Use Stock Mate to record feedings, milk tests, vaccinations, artificial inseminations, 
births, weights, and just about any information for your animals. 

 
§ Guide Mate – The guidance module of the Farm Works Mate software adds an onscreen 

lightbar to keep you on a straight path while tilling, planting, applying or harvesting.  
Developed by Raven Industries, a business with decades of experience in GPS 
technology, Guide Mate works on both a PDA and the large-screen Titan RT.  You can 
use the program’s easy-to-follow onscreen lightbar, or use an exterior lightbar, such as 
the wireless MicroGuide Bluetooth lightbar.  Guide Mate is fully integrated with Site 
Mate, so you can conveniently display your maps (such as field-boundaries, as-applied 
coverage maps, or variable-rate prescription maps) at the same time that you use the 
program’s guidance feature.
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Working with Projects      

Working with Projects 
Every time you start Farm Trac, the program greets you with the Project Selection dialog box, 
which you use to open an existing project, create a new project, change the name or password for 
a project, copy or delete a project, or restore a backup of a project.  When you run Farm Trac for 
the first time, you must use the Project Selection dialog box to create your first project.  The 
project you create with Farm Trac is where the program saves all the records for your farm 
including your soil-sample maps, variable-rate-application prescription maps, and yield maps.   
 
Only one project can be open at a time and information from two projects cannot be merged 
together. Most users generally have just one project they use on a daily basis.  You can, however, 
create additional projects or copy existing projects. This will give you the option of choosing the 
project in which to work each time you run the program.  After the program opens a project, you 
have the option of making a backup of that project using the Backup Project command on the 
File menu. 
 
This chapter explains how to use the Project Selection dialog box to create a new project, change 
the name or password for an existing project, and copy or delete a project.  It also covers how to 
make and restore a Farm Works backup of your project. 
 

Creating New Projects (Farm Trac) 
 
The first time you run Farm Trac, you must use the Project Selection dialog box to create a 
project before you can begin using the program.  If you have already created a project, you can 
also use the dialog box to create a new project if needed. 
 
To create a project: 

1. Open Farm Trac by double-clicking the Farm Works shortcut on your Windows 
desktop, or by selecting the Windows Start button, pointing to Programs (or All 
Programs in Windows XP), pointing to Farm Works Software, and selecting the 
Farm Works shortcut.   

 
2. In the Project Selection dialog box that opens, select the New Project button to open 

the Add New Project dialog box. 
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3. In the Add New Project dialog box, enter the name for your project in the Project 
Name box. 

 
4. You may protect your project with a password by entering a password in the Password 

box (optional).  (The password is case sensitive; so make sure the Caps Lock of your 
keyboard is not on.  It can have up to eight letters and numbers, but cannot have any 
special characters, such as the at sign (@) or tilde (~). If no password is needed, simply 
leave the Password box blank.) 
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5. To remove password protection from the project, highlight the password you entered in 
the Password box and press the Delete key on your keyboard. 

 
6. Select OK, and the Project Selection dialog box now displays the name of the new 

project. 
 
 

7. To open the new project, select the project name to highlight it and select OK. 
 

 
 

8. If you added password protection to the project, Farm Trac displays the Project 
Password dialog box.  Enter the correct password and select OK. 

 
9. The Measurement System dialog box opens in which you must select either US-

English or Metric (Farm Trac will use the measurement system you choose from now 
on). 
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10. To close the dialog box without opening a project, select Cancel. 

 

 
 

Farm Trac opens the new project so you can begin working in it, or you can select Restore 
Backup on the File menu to restore a Farm Works backup of a project that you made previously.  
You can follow the instructions of this section to create as many new projects as you like, but 
only one project is necessary.  For instructions on restoring a Farm Works backup of a project, 
see the section of this chapter on that topic. 
 

Changing Project Information (Farm Trac) 
 
At any time you can change the name or password for a project using the Project Selection 
dialog box. Changing a project’s name or password will not change any of the farming 
information you recorded in that project. You can also add a password to a project that does not 
have password protection, or remove a password from a project. 
 
To change a project’s name, or to add, remove or change a password: 

1. Open Farm Trac by double-clicking the Farm Works shortcut  on your Windows 
desktop, or by selecting the Windows Start button, pointing to Programs (or All 
Programs in Windows XP), pointing to Farm Works Software, and selecting the 
Farm Works shortcut. 

 
2. In the Project Selection dialog box that appears, select the name of the project for which 

you want to make changes and select the Change Project Info button. 
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3. The Project Info dialog box that opens displays the name of the project in the Project 
Name box.  To change the project name, highlight its name in the box and enter a new 
name. 

 
4. You may protect your project with a password by entering a password in the Password 

box (optional).  (The password is case sensitive; so make sure the Caps Lock of your 
keyboard is not on.  The password can have up to eight letters and numbers, but cannot 
have any special characters, such as the at sign (@) or the tilde (~).) 

 

 
 

5. To remove password protection from the project, highlight the password in the 
Password box and press the Delete key on your keyboard. 

 
6. Select OK to save the changes to your project. The Project Selection dialog box now 

displays the new name of the project. 
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- or - 
 
Select Cancel to return to the Project Selection dialog box without saving the changes. 

 
7. To open the project and begin working in it, select the project name and select OK. 

 

 
 

8. If you added password protection to the project, Farm Trac displays the Project 
Password dialog box where you can enter the correct password and select OK. 

 
9. To close the dialog box without opening a project, select Cancel. 

 
You can follow these instructions to make changes to your project as often as you like.   If you 
added a password to a project, Farm Trac will require you to provide the password whenever you 
try to open, modify, copy or delete the project.  For instructions on copying or deleting projects, 
see the sections of this chapter on those topics. 
 

Copying Projects (Farm Trac) 
 
There are times when you might want to make a copy of your project with Farm Trac.  For 
example, you could make a copy of a project to use to teach yourself how to use the program, or 
copy a project to test how a certain task will affect the project copy before you perform the task 
in your original project.  To make a copy of your project: 

1. Open Farm Trac by double-clicking the Farm Works shortcut on your Windows 
desktop, or by selecting the Windows Start button, pointing to Programs (or All 
Programs in Windows XP), pointing to Farm Works Software, and selecting the 
Farm Works shortcut.   
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2. In the Project Selection dialog box that opens, select the name of the project for which 
you want to make a copy and select the Copy Project button. 

 

 
 

3. The Copy Project dialog box that opens displays the name of the project for which you 
are making a copy in the Source Project box (verify this is the correct project). 

 
4. Enter the name you want to give the copy in the New Project box. 

 
5. If you want to password protect the project copy, you may enter a password in the New 

Password box (optional).  (The password is case sensitive and can have up to eight 
letters and numbers, but cannot have any special characters, such as the at sign (@).) 

 

 
 

6. To remove password protection from the project, highlight the password you entered in 
the New Password box and press the Delete key on your keyboard. 
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7. Select OK to save the copy of your project, or Cancel to not save the copy of your 

project.  (If you select OK, the Project Selection dialog box displays the name you gave 
the copy of your project under the name of the original project.) 

 
8. To open the copied project, select its name to highlight it and select OK. 

 

 
 

9. If you added password protection to the project, Farm Trac displays the Project 
Password dialog box.  Enter the password you added to the copied project. 

 
10. To close the dialog box without opening a project, select Cancel. 

 
Farm Trac opens the copy of your project so you can begin working in it.  The fields, inputs, 
farming operations and maps for the copied project will be the same as those of the original 
project until you make any modifications.  You can delete the project copy any time you like.  
Follow the instructions of this section to create as many copies of your project as desired.  For 
instructions on deleting a project, see the next section of this chapter. 
 

Deleting Projects (Farm Trac) 
 
If you have made a copy of a project that you no longer need, or have a project that you no 
longer use, you can delete that project.  Deleting a project will permanently remove its name 
from the Project Selection dialog box and erase its data from your computer’s hard drive 
(including its maps). Be certain you no longer need a project before you delete it.  
 
We strongly recommend you make a Farm Works backup of a project before you delete it, as 
restoring a backup is the only way to recover a project’s data after you remove it.  For 
instructions on creating a backup of a project, see the next section of this chapter.  To delete a 
project: 
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1. Open Farm Trac by double-clicking the Farm Works shortcut on your Windows 
desktop, or by selecting the Windows Start button, pointing to Programs (or All 
Programs in Windows XP), pointing to Farm Works Software, and selecting the 
Farm Works shortcut. 

 
2. In the Project Selection dialog box that appears, select the name of the project you want 

to delete, verify the highlighted name is the correct project to remove, and select the 
Delete button. 

 

 
 

3. If you added password protection to the project, Farm Trac displays the Project 
Password dialog box, where you must enter the password and select OK (Farm Trac 
will not allow you to delete the project until you provide the correct password). 

 
4. The program displays a message with the name of the project you are about to remove, 

which asks you to confirm that you want to delete it.  Select Yes to delete it or No to 
cancel deletion. 

 

 
 
If you select Yes, Farm Trac removes the project name from the Project Selection dialog box and 
permanently erases the data for the project from your computer’s hard drive.  As previously 
stated, the only way to recover a project after you delete it is to restore a backup of that project 
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that you created before you deleted the project.  For instructions on creating a Farm Works 
project backup, see the next section of this chapter. 
 

Backing up Projects (Farm Trac & Site Pro) 
 
One of the most important things you can do is to make frequent backups of your Farm Works 
projects using the backup feature of Farm Trac.  Should something go wrong with your 
computer, such as a catastrophic hardware failure or an infection by a computer virus, you can 
restore the backup of your project in an attempt to recover any lost data.  Without a project 
backup to restore, there might be no way to recover the records and maps for your farm. It is 
recommended to make periodic backups to something other than your hard drive (USB, CD, hard 
disk, etc) in case of failure, loss, or damage. 
 
Use the following instructions to easily make a project backup: 
 

1. Select Backup Project on the File menu in the upper, left-hand corner of the program. 
 

2. In the Backup Project dialog box that appears, enter the name you want to give the 
backup in the Backup To box, or replace a backup you made previously by selecting the 
list button  and selecting the backup you want to replace in the list. 

 

 
 

3. The default folder where Farm Trac saves your Project backups is the Backup folder, 
which is in the Farmproj (Sitepro) folder on your computer’s hard drive.  Use the 
following instructions to save the backup to a different folder (such as your My 
Documents folder) or to a USB or other removable drive: 

 
• In the Backup Project dialog box, select the Browse button. 
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• In the Save As dialog box that opens, select the folder or removable drive where 
you want to save the backup in the Save In list. 

 
- or - 
 
Select an icon on the left-hand column of the dialog box and browse to the folder 
or drive where you want to save the backup  (for example, to save the backup to a 
USB drive, select the My Computer icon  and select the drive letter for the 
removable drive to enter it in the Save In box). 
 

• Enter a name for the backup file in the File Name box, or replace a previous 
backup by selecting the backup file in the box above the File Name box. 

 
• Select the Save button to return to the Backup Project dialog box (Farm Trac 

will add the name of the backup to the Backup To box). 
 
- or - 
 
Select Cancel to close the dialog box without saving the backup. 
 

4. In the Backup Project dialog box under Options, you can change the size that the 
backup file will be, and the amount of time it will take to create the backup, by selecting 
a different value in the Compression list—choose Maximum (Slowest), Normal, Fast, 
Super Fast, or None.  (Choosing maximum compression will cause Farm Trac to take 
the longest time to create the backup but the backup will be a smaller file.  Choosing no 
compression will cause the program to take the shortest time to create the backup but it 
will be a much larger file.) 

 
5. If you are saving the backup to a USB drive or a floppy disk, select Wipe Disk in the 

Disk Prep list if you want to erase all files on the USB drive or floppy disk before 
making the backup.  (Before you select Wipe Disk, be careful to verify there are no files 
you want to keep on the disk or removable drive.) 

 
6. Select the Include Backdrops check box to include background images, such as aerial 

photos and satellite imagery in the backup. These images will increase the file size of the 
backup. 

 
7. Select OK and Farm Trac will show the progress as it saves the backup to the folder, 

removable drive, or floppy disk you chose. 
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8. Select Cancel to close the dialog box without making a backup. 
 

9. Repeat the previous steps to save another backup to a different folder, removable drive, 
or floppy disk. 

 

Restoring Project Backups (Farm Trac & Site Pro) 
 
Should something go wrong with your computer that corrupts the data of your farm project, you 
can attempt to recover the data by restoring a Farm Works backup of your project. Restoring a 
project backup replaces the information in the current project with the information that was in 
the project at the time you made the backup.  (For example, if you made a backup of your project 
on Monday and decide to restore the backup on Friday of the same week, you will lose all 
information entered Tuesday through Thursday of that week.) 
 
Farm Trac will only restore backups you made with the program.  The program will not restore 
backups made with other backup software, such as the Windows XP Professional backup utility.  
For instructions on making a Farm Works backup of your project, see the previous section of this 
chapter. 
 
To restore a project backup: 
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1. In the Project Selection dialog box select the project to which you want to restore the 
backup and select the Restore Project button. (Farm Trac only) 
 
- or - 
 
Select the Restore Backup on the File menu of Farm Trac. (Farm Trac or Site Pro) 
 

 
 

2. If you previously added a password to the project, Farm Trac will display the Project 
Password dialog box where you must enter the correct password. (Farm Trac only) 

 
3. In the Restore Backup dialog box that appears, select the name of the backup you 

previously made in the Backup Project list. 
 

4. If the backup you made is not in the list, browse to locate it: 
 

• Select the Browse button to open a second Restore Backup dialog box. 
 

• In this Restore Backup dialog box, select the folder or drive where you 
previously saved the backup in the Look In list. 

 
- or - 
 
Select an icon on the left-hand column and browse to the folder or removable 
drive where you previously saved the backup (for example, if you saved the 
backup to your My Documents folder, select the My Documents icon  to enter 
it in the Look In list). 

 
• Select the backup file in the box under the Look In list to add its name to the File 

Name box. 
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• Select Open to return to the previous Restore Backup dialog box, where Farm 
Trac enters the name of the backup in the Restore From box. 

 
- or - 
 
Select Cancel to close the dialog box without restoring the backup. 
 

5. In the Restore Backup dialog box, select the project to which you want to restore the 
backup in the Project Name list (Farm Trac will replace all the data in the project you 
choose).  You can also enter a new project name if you do not want to replace a current 
project. This will create a complete new project. (Farm Trac only) 

 

 
 

6. Select OK, and a message asks if you are sure you want to continue with the backup 
process. 

 
7. Select No if you do not want to restore the backup. 
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8. Select Yes and Farm Trac shows the progress as it restores the backup. 

 

 
 

During the restoration of the backup, the program replaces the current data in your project with 
the data in the backup file.  The restoration process will replace all information in your current 
project (including all your maps) with the information in the backup file.  When the restoration is 
complete, you can begin working in the restored project. 
 
In the next chapter, you will read how to add fields and inputs (such as equipment, people and 
supplies) to your project.  After you add your fields and inputs, you can begin using Farm Trac to 
record your farming operations and print reports. 
 

Changing User Information 
 
The contact information that is printed on many reports comes from the User Information entered 
in Farm Trac. 
 
To change the User Information: 
 

1. On the File menu, select Preferences and User Info… 
 

2. In the User Information dialog box, enter the Name, Address, Phone Number, and 
Fax Number that you want to show up on reports printed from Farm Trac. 

 
3. When finished, press OK.



Farm Trac Reference Guide 

26 



Farm Trac Reference Guide 

27 

Adding Fields and Inputs       
Adding Fields and Inputs 
Before you can begin recording farming operations with Farm Trac, you must add your farms, 
fields, and inputs to the program.  Site Pro users must also add Clients.  You add your farms and 
fields to the Farm box, and your inputs (which are your workers, equipment, and supplies) to the 
Inputs box.  The Farm and Input boxes are both located in the left-hand column of the program. 
 
Setting up your farms and fields takes very little time.  All you have to do is enter the names of 
your farms, and the names, legal acres and tillable acres for your fields.  If desired, additional 
details can be added for your fields, such as FSA information.  If you have the Farm Site 
program installed with Farm Trac or if you are using Site Pro, you can draw or import maps of 
your fields. You can still perform farming operations even if you have not added field maps with 
Farm Site. 
 
Setting up workers (such as employees) and machines (such as tractors, combines, and sprayers) 
is also easy.  All you are required to enter is certain general information such as names and 
charge units for each item.  If desired, you can add additional data, including addresses and 
license numbers for your workers as well as service intervals for your equipment. 
 
Setting up your supplies requires the most documentation.  You should enter the correct purchase 
units and distributed units for each supply when first entering them.  For fertilizers, you must 
record the appropriate percentages for nitrogen, phosphorus, potassium, or other nutrients.  For 
herbicides, insecticides, and other chemicals, you should decide whether to have Farm Trac keep 
detailed chemical records.  If necessary, you can also document protective equipment and 
restricted-reentry requirements. 
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This chapter explains how to add your farms, fields, workers, machines and supplies to Farm 
Trac.  The sections of this chapter follow a logical sequence for setting up your fields and inputs, 
but you can set them up in any order you prefer. 
 

Using the Job-Resources Tools Toolbar 
 
At the top of Farm Trac under the menu bar is the Job/Resources Tools toolbar. 
 

 
 

The Job/Resources Tools toolbar has 11 toolbar buttons for performing many of the tasks of the 
program: 

  New Farm toolbar button allows you to add new farms to the program. 

   New Field toolbar button lets you add new fields to the program. 

  New Structure toolbar button enables you to add structures, such as bins or 
barns. 

  New Person toolbar button gives you the ability to add laborers, employees and 
other workers. 

  New Machine toolbar button allows you to add equipment, such as tractors, 
planters and combines. 

   New Supply toolbar button lets you add supplies to your inventory, such as seeds, 
fertilizers and chemicals.  

  New Animal toolbar button enables you to add livestock. 

  Read Job Data toolbar button gives you the ability to import yield and other 
data into the program. 

  Write Job Data toolbar button allows you to export maps and other data from 
the program.  
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  Synchronize Trac Mate toolbar button lets you synchronize Farm Trac with 
Trac Mate running on a handheld computer or with a USB drive for use with a 
Titan RT. 

  All Reports toolbar button enables you to select reports to print or export. 
 

Setting Up Clients and Farms (Site Pro only) 
 
Site Professional has the capability of supporting multiple clients. This allows consultants and 
users with multiple clients to keep the information between clients separate. Clients can be 
created when creating a new farm or a new field. Clients show under the farm box as folders 
with fields and farms listed under each. There will also be a Common folder that is used for 
information common to all clients (background maps, roads and waterways, etc.) 
 
To add a Client to Site Pro: 
 

1. Select the Farm tab , right-click the Common folder , and select 
New Client on the shortcut menu. 
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2. In the Client Properties dialog box that appears, enter General, Address, and Contact 

information under the appropriate tabs.  
 

3. Press OK to create the new Client. The new Client will display in the Farm box as a new 
folder. 

 
Farms and Fields can now be created under the new client. Clients can also be created when 
adding Farms and Fields. For more information, see the following sections. You can view and 
modify a client’s information by right-clicking its name in the Farm box and selecting Client 
Properties. 
 
If you find you no longer need a client, you can either delete or retire the client.  You cannot 
delete clients for which you have recorded planned or completed farming operations, but must 
retire them instead.  To delete a client for which you have not entered a planned or completed 
farming operation, right-click the client’s name in the Farm box and select Delete.  To retire a 
client for which you have entered a planned or completed farming operation, right-click the 
client’s name and select Retire.  When you retire a client, Farm Trac will add an asterisk to the 
client’s name or remove the client from the Farm box.  The program will still keep the retired 
client’s farming history in case you need to see it in the future. To display/hide retired clients in 
the Farm box, go to the View menu and select Show Retired Land Areas. 

Setting Up Farms 
 
Farm Trac allows you to have farms in which to group your fields.  Multiple farms are generally 
used with different landlords, as you can organize your fields by farm name.  Once you add your 
farms to the Farm box, you can begin adding your fields. You can also move fields that you 
previously added to the program to the farm you just created (for instructions on adding your 
fields to Farm Trac, see the next section of this chapter).   
 
To add a new farm: 
 

1. Select New Farm on the Resources 
menu. 

 
- or - 
 
Select the New Farm toolbar button.  

 
 
- or - 
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Select the Farm tab , right-click the <Unknown> farm icon , and select New 
Farm on the shortcut menu. 
 

2. In the Farm Properties dialog box that appears, enter a name for the farm in the 
Description box. Client will always be “Common” unless using Site Pro. If a Client 
needs to be created, choose <Add> and follow the instructions in the section on creating 
clients. You will not be able to fill in the area boxes here as these numbers will come 
from the individual fields. 

 
3. In the Notes box, enter any miscellaneous information for the farm (you can enter up to 

255 characters). 
 

 
 
Now that you have your Farms set up, you will now be able to add Fields under each Farm.  You 
can view and modify a farm’s information by right-clicking its name in the Farm box and 
selecting Farm Properties. 
 
If you find you no longer need a farm, you can either delete or retire the farm.  You cannot delete 
farms for which you have recorded planned or completed farming operations, but must retire 
them instead.  To delete a farm for which you have not entered a planned or completed farming 
operation, right-click the farm’s name in the Farm box and select Delete.  To retire a farm for 
which you have entered a planned or completed farming operation, right-click the farm’s name 
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and select Retire.  When you retire a farm, Farm Trac will add an asterisk to the farm’s name or 
remove the field from the Farm box.  The program will still keep the retired farm’s farming 
history in case you need to see it in the future. To display/hide retired farms in the Farm box, go 
to the View menu and select Show Retired Land Areas. 
 

Setting Up Fields 
 
With Farm Trac you can quickly set up your fields so you can begin recording farming 
operations.  All you have to do is enter the field names, tillable and legal acres for your fields, 
and indicate whether you own, cash rent or share crop the fields.  You can also add additional 
information for your fields, including FSA information (optional).  Photographs of your field 
taken with a digital camera, scanned in, etc can also be added to the field information.  Farm 
Trac allows you to group your fields by farm. Farms must be added to the Farm box, which is in 
the left-hand column of the program (for instructions on adding farms, see the previous section 
of this chapter). 
 
To add a new field: 
 

1. Select New Field on the Resources 
menu. 
 
- or - 
 
Select the New Field toolbar button.  

 
 
- or - 
 

 
 

Select the Farm tab , right-click the icon of the farm  for which you will add 
the field, and select New Field on the shortcut menu.  (If you have not added a farm, 
right-click on the <Unknown> farm and select New Field.  For instructions on adding a 
farm, see the section on that topic in this chapter.) 
 

2. The Field Properties dialog box that appears has four tabs you can select to enter field 

data: . (The Landlords tab will not be 
displayed if Farm Funds is not installed.) On the General tab page: 

 
• Enter a name for the field in the Description box. 

 
• Under Area, enter the number of Legal and Tillable acres. (Tillable acres will be 

used in field records. Mapped acres are calculated automatically from mapped 
boundaries. ) 
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• Under Owner/Landlord, select the Farm that the field belongs to (You may also 

choose <Unknown Farm> if you don’t know or <Add> to add a Farm that is not 
in the list).  Client will always be “Common” unless using Site Pro. 

 
• Select whether the field is Owned, Cash Rented, or Share Cropped. 

 

3. Select the  tab to enter FSA and Legal information about the field (optional). 
 

• Select the appropriate County where the field resides, or select <Add/Edit> to 
add a county to the drop down list. Select the Add button in the dialog box, and 
enter the name of the county. 

 
• Under FSA, enter the appropriate information in the FSA Farm #, Field #, Track 

# and Land Class boxes. 
 

• Under Legal, enter the correct information in the Section #, Township # and 
Range # boxes. 

 
• If desired, you may enter a brief description of the field in the Description box 

(you can enter up to 255 characters, spaces and punctuation marks). 
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4. If the Field is Share Cropped, select the  tab. 
 

• Select the Landlord or select <Add/Edit> to add a Landlord to the drop down list. 

If there are multiple landlords for the same field, press the  
button. You can remove a Landlord from the field with the  
button. 

 
• If the billed items and the percentages are the same as another previously entered 

field, you can press the  button to keep from entering 
all of the information again. Simply select which field the landlord information 
should be copied from. 

 
• Fill in the percentage of the crop that each landlord receives.  Also, select which 

Inputs the landlord gets billed for and what percentage they pay.  You can press 
the Fill Col. button if all items are billed at the same percentage. 

 

• If the Landlord gets billed for any equipment usage, press , select 
the equipment that they get charged for, and enter the Charge/Unit. 
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5. To add a digital photograph of the field, select the  tab (optional). 
 

• Select the  button. 
 

• In the Change Photo dialog box, select the folder where you previously saved a 
digital photograph of the field (such as the My Pictures folder). 

 
• Select the image file of the digital photograph of the field, and select Open (the 

image file can be a bitmap (.bmp), Joint Photographic Experts Group (.jpg), 
Tagged Image File Format (.tif), or PC Paintbrush (.pcx) file). 
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• The digital photograph of the field appears in the Field Properties dialog box.  

To choose a different photograph, select the  button once 
more. 
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• To print the photograph of the field, select the  button. 
 

• To remove the photograph, select the  button (removing the 
photograph from the Field Properties dialog box will not delete the image file 
from your computer’s hard drive or removable drive). 

 
6. When you finish entering the information that you want for the field, select OK.  The 

field name will now appear under the selected Farm in the Farm box. 
 
View and modify the information for a field any time by right-clicking the field’s name in the 
Farm box and selecting Field Properties to open the Field Properties dialog box once again.  In 
the dialog box you can make the desired changes and select OK to save the changes.  For 
example, you can move a field from the <Unknown> farm to a different farm by selecting the 
name of a farm you added in the Farm list. 
 
If you find you no longer need a field, you can either delete or retire the field.  You cannot delete 
a field for which you have recorded planned or completed farming operations, but must retire 
them instead.  To delete a field for which you have not entered a planned or completed farming 
operation, right-click the field’s name in the Farm box and select Delete.  To retire a field for 
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which you have entered a planned or completed farming operation, right-click the field’s name 
and select Retire.  When you retire a field, Farm Trac will add an asterisk (*) to the name of a 
field or remove the field from the Farm box.  The program will still keep the retired field’s 
farming history in case you need to see it in the future. To display/hide retired fields in the Farm 
box, go to the View menu and select Show Retired Land Areas. 
 

Setting Up Machinery 
 
Farm Trac makes it easy to set up the machinery that you use to perform farming operations. 
(combines, tractors, planters, sprayers, etc).  You can organize your machines into categories of 
application, baling/forage, farm maintenance, harvesting, hauling/transport, land preparation, 
other, planting/seeding and tractors.  The program can also keep track of detailed information for 
your machines, including when the last service was completed and when the next service is due. 
 
When you add machines to the Working Group box and select the Apply to Fields button, you 
can choose the fields in which you use your machines and the types of farming operations they 
perform.  Farm Trac calculates and displays the charge units (such as the number of acres 
farmed) and costs (such as the dollars per acre) for your machines.  For machines you set up to 
use fuel, the program automatically calculates the amount of fuel used on the jobs performed.  If 
you have installed Farm Funds together with Farm Trac, the program tracks costs of repairs and 
fuel for your machinery. 
 
To add a new machine: 
 

1. Select New Machine on the 
Resources menu. 

 
- or - 
 
Select the New Machine toolbar 
button.   
 
- or - 
 

Select the Inputs tab,  right-
click the Machines icon, and 
select New Machine on the shortcut 
menu. 

 

 

 
2. The Machine Properties dialog box that appears has four tabs you can select to enter 

information for the machine - . Under the 

 tab: 
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• Enter a name for the machine in the Description box. 
 

• Select the type of machine in the Category list (application, baling/forage, farm 
maintenance, harvesting, hauling/transport, land preparation, other, 
planting/seeding or tractors). 

 
• Under Model, enter the make, model, year and serial number for the machine. 

 
• Enter the Console ID# under Console (AGCO GTA users only). 

 
• Under Operation, select how you want the machine to be charged (by the acre of 

hour) in the Charge Unit list. Enter the rate per acre or hour in the Charge Rate 
box for the machine. 

 
§ The charge rate will be used on the enterprise statements and get directly 

applied to the acres that the machine covers if Farm Trac is installed 
without Farm Funds.  This rate will also be applied on planned operation 
reports. 

 
§ If Farm Funds is installed and Profit Enterprise is selected for the 

equipment, the charge rate will also go directly to the fields covered by the 
equipment.  If Passive Enterprise is selected, the charge rate will only be 
used for planning reports.  Enterprises will be covered more in the Farm 
Funds Manual. 

 
• Enter the implement width in the Width box. (This is only necessary if using 

TracMate) 
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3. To keep track of service records for the machine, select the  tab. 
 

• Select the Service Interval Unit (Acre or Hour). 
 

• In the Current Meter box, enter the current acres or hours on the machine. 
 

• In the Last Serviced box, enter the acres or hours at the time of the last service. 
 

• In the Last Service Date box, enter the date of the last service, or select the 
calendar button  and choose the date in the calendar. 

 
• In the Service Interval box, enter the number of acres or hours to elapse between 

each service (Farm Trac automatically calculates and displays the number of 
hours or acres until the next service is due in the Next Service box). 

 
• Enter any Service Notes in the box (you can enter up to 255 characters). 
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4. Select the  tab. 
 

• Select the Harvester check box if you will use the machine to perform harvesting 
operations. (Combines, balers, etc.) 

 
• Select the Fuelable check box if you want Farm Trac to track fuel use for the 

machine. 
 

• If the machine uses fuel, select the correct fuel type in the Supply Fuel list. (The 
supply fuel must be already set up under supplies)  Enter the Default Burn Rate, 
and select Gal/Acre or Gal/hr. 

 
• If Farm Funds is being used, select Passive or Profit Enterprise under Enterprise 

Type. (Enterprise Type will be explained in the Farm Funds manual) 
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5. Add a digital photograph of the machine by selecting the  tab (optional). 
 

• Select the  button. 
 

• In the Change Photo dialog box, select the folder where you previously saved a 
digital photograph of the machine (such as the My Pictures folder). 

 



Farm Trac Reference Guide 

43 

 
 

• Select the image file of the digital photograph, and select Open (the image file 
can be a bit map (.bmp), Joint Photographic Experts Group (.jpg), Tagged Image 
File Format (.tif), or PC Paintbrush (.pcx) file). 

 
• The digital photograph appears in the Machine Properties dialog box.  To choose 

a different photograph, select the  button once again and 
choose a different image file in the Change Photo dialog box. 
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• To print the photograph of the machine, select the  button. 
 

• To remove the photograph, select the  button (removing the 
photograph will not delete the image file from your computer’s hard drive or 
removable drive). 

 
6. When you finish entering the information for the machine, select OK.  The machine now 

appears in the Inputs box, where you will find it under the appropriate machine category 
 under the Machines icon.  

 
At any time you can open the Machine Properties dialog box so you can view or change the 
machine’s information by right-clicking the name of the machine in the Inputs box and selecting 
Properties on the shortcut menu.  If you find you no longer need a machine, you can delete or 
retire the machine.  You cannot delete a machine you have used in a planned or completed 
farming operation, but must retire it instead. 
 
To delete a machine you have not used in a planned or completed farming operation, right-click 
the machine’s name in the Inputs box and select Delete. 
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To retire a machine you have used in a planned or completed farming operation, right-click the 
machine’s name and select Retire.  When you retire a machine, Farm Trac will add an asterisk 
(*) to the machine’s name or remove its name from the Inputs box.  The program will still keep 
the farming history for the retired machine for future reference. To display/hide retired inputs in 
the Farm box, go to the View menu and select Show Retired Inputs. 
 

Setting Up People 
 
You can use Farm Trac to track the operations that your employees or other workers perform.  
When you add workers to the Working Group box and select the Apply to Fields button, Farm 
Trac allows you to choose the fields in which the workers do the work, the types of operations 
they perform, the number of hours it takes to finish the operation, and their rates of pay.  If you 
have installed Farm Funds together with Farm Trac, the program keeps track of the dates and 
hours worked, and accurately calculates payroll for you. 
 
Before you begin recording jobs for your workers, you must add them to the Inputs box. To add 
a new worker: 
 

1. Select New Person on the 
Resources menu. 

 
- or - 
 
Select the New Person toolbar 
button.   
 
- or - 
 

Select the Inputs tab,  right-
click the People icon,  and select 
New Person on the shortcut menu. 

 

 

 
2. The Person Properties dialog box that appears has tabs you can select to enter 

information.  

 The 
Payroll tab will only show if Farm Funds is installed. Farm Trac only requires you to 
enter a first or last name for the worker on the General tab page, the rest of the 
information is optional. 

 
The Person Properties instructions are also used when adding contacts.  All details 
mentioned are not necessarily for employees only. Some of the information entered will 
be applicable to business contacts, landlords, vendors, etc. 
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• Check the Business box to add a name of a business as a contact. 
 

• Select the person’s Title, enter their First, Middle, and Last name, and select the 
appropriate Suffix. 

 
• The Full Name and Sorted Name will automatically fill in. You may change 

these to your preference.  The Sorted Name is how it will show up in all of the 
lists within Farm Trac. 

 
• You can also enter the name of the Business for which the person works, their 

appropriate Job Title, and Tax ID (Farm Funds only). 
 

 
 

3. Select the  tab to add a mailing address for the person. 
 

• Enter their P.O. box, rural route, or street address in the Street 1 and Street 2 
boxes. 
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• Enter the person’s City/Town, State/Province, Zip/Postal Code, and Country in 
the appropriate boxes. 

 

 
 

4. Select the  tab to enter all relative contact information such as a business 
telephone number, mobile phone number, or e-mail address. 
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5. Select the  tab and select the check boxes that apply to the contact: 
 

• Select Sell To if this person will purchase items from your farm. 
 

• Select Buy From / Pay To if your farm will purchase items from the contact. 
 

• Select 1099 Required if you the Federal Government will require you to fill out a 
Form 1099. 

 
• Select Landlord if the added person is one of your landlords. 

 
• Select Other if the contact fits some other category. 
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6. Select the  tab to record employee license number and charge rate. 
 

• If the employee has a pesticide applicator’s license, enter the license number here 
and it will show up on all application reports for that employee. 

 
• Enter the Charge Rate in dollars per hour that the employee gets paid.  This 

charge rate is very similar to the charge rate used for machinery.  Without Farm 
Funds, this cost will get allocated directly to each operation that the employee 
performs.  If Farm Funds is installed, this rate will only be used for planning 
operations and payroll will determine the costs that get applied to each field 
operation. 
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7. The  tab will be covered in the Farm Funds manual. 
 

8. Select the  tab to add a digital photograph of the contact: 
 

• Select the  button. 
 

• In the Change Photo dialog box, select the folder where you previously saved a 
digital photograph of the worker (such as the My Pictures folder). 
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• Select the image file of the digital photograph, and select Open (the image file 
can be a bit map (.bmp), Joint Photographic Experts Group (.jpg), Tagged Image 
File Format (.tif), or PC Paintbrush (.pcx) file). 

 
• The digital photo appears in the Person Properties dialog box.  To change the 

photograph of the worker, select the  button to open the 
Change Photo dialog box once again. 

 



Farm Trac Reference Guide 

52 

 
 

• To print the worker’s photograph, select Print Photo. 
 

• To remove the photograph, select Remove Photo (removing the photograph will 
not delete the image file from your computer’s hard drive or removable drive). 

 
9. When you finish entering the information for the worker, select OK (the worker now 

appears in the Inputs box under the People icon).   
 
You can later open the Person Properties dialog box to review or change the worker’s 
information by right-clicking the worker’s name in the Inputs box and selecting Properties.  If a 
person is no longer an employee, you can delete or retire the worker.  You cannot delete a 
worker who you used in a planned or completed job, but must retire the worker instead.  To 
delete a worker you have not used in a planned or completed farming operation, right-click the 
worker’s name in the Inputs box and select Delete. 
 
To retire a worker you have used in a planned or completed farming operation, right-click the 
worker’s name and select Retire.  When you retire a worker, Farm Trac will add an asterisk to 
the worker’s name, or remove the name from the Inputs box.  The program will keep the work 
history for the retired worker for future reference.  To display/hide retired employees in the Farm 
box, go to the View menu and select Show Retired Inputs. 
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Setting Up Supplies 
 
Farm Trac allows you to keep comprehensive information for all of the supplies you apply to 
your fields such as seeds, fertilizers, insecticides, and other chemicals.  You can record detailed 
chemical information and re-entry restrictions for applicable chemicals and document the 
analysis of nitrogen, phosphorus, potassium and other nutrients for your fertilizers. 
 
When you add supplies to the Working Group box and select the Apply to Fields button, you will 
then choose which fields to apply the inputs.  Farm Trac calculates and displays the number of 
acres and the quantities used for the applications.  If you have Trac Mate installed on a handheld 
computer or the Titan RT, the Synchronize Trac Mate feature of Farm Trac can be used to copy 
the supply data for a planned job to Trac Mate.  Costs of supplies will get allocated to the fields 
that the supply gets used on. 
 
Before you can begin recording farming operations, you must add the supplies to the Inputs box.  
To add a new supply: 
 

1. Select New Supply on the 
Resources menu. 

 
- or - 
 
Select the New Supply toolbar 
button.   
 
- or - 
 

Select the Inputs tab,  right-
click the Supplies icon,  and select 
New Supply on the shortcut menu. 

 

 

 
2. The Supply Properties dialog box opens and has the following tabs to record 

information for the supply:   
Under the  tab: 

 
• Enter a name for the supply in the Description box. 

 
• If relevant, enter the Part # number for the supply. 

 
• If Farm Funds is installed, you will have to select the applicable account. 

 
• Select the Add to Markers check box, if applicable. (Agco GTA users only) 
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• Under Type, select the supply category (choose Herbicide, Insecticide, 

Fungicide, Nematicide, Rodenticide, Seed, Fertilizer/Lime, Adjuvant, 
Growth Regulator, Other Chemical, Feed, Fuel, or Other Non-Distributed 
Item). 

 
• Enter the Purchased Units, Unit Cost, Distributed Unit, and the Default 

Application Rate.  Farm Trac will automatically fill in the conversion value. 
 

• Unit cost is similar to charge rate for machinery and people.  This will be 
used on Enterprise statements if Farm Trac is installed without Farm 
Funds as well as on planned operation reports.  If Farm Funds is installed, 
it is still important to enter this value, as it will still be used on all planned 
operation reports. 

 

3. To keep detailed chemical records for the supply, select the  tab.  If you 
choose to keep detailed chemical records for a supply, Farm Trac will keep records of 
field and weather information each time the supply is used. 

 
• Select the Keep Detailed Chemical Records check box. 

 
• Enter all of the applicable information about the supply.  This information should 

be taken from the label on the chemical. 
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• Add target problems in the Target Problems box by selecting the Add/Edit 
Problem List button, which opens the Pest Selection dialog box. 
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• In the Pest Selection dialog box, select the pests controlled by the chemical in the 
Pests box (select more than one by holding down the Ctrl key as you click them 
with your mouse), and then select the  button to add them to the 
Selected Pests box. A maximum of 5 pests can be selected. Many times, a broad 
term such as “Broadleaves” or “Grasses” can be used to narrow the list. 

 
• To remove pests from the Selected Pests box, select them in the box and select 

the  button, or select  to remove all. 
 

• If you need to add a new pest to the Pest Selection dialog box, select Add/Edit to 
open the Pests dialog box, select the Add button, and enter the name of the new 
pest. 

 

4. If the supply you add is a fertilizer, select the Fertilizer tab  and complete 
the following: 
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• In the Fertilizer Nutrients box, select the first nutrient and the percent of the 
analysis that nutrient makes up in the Percent % column. The picture below 
shows an example of liquid 10-34-0. 

 
• Select the Add Nutrient button to add a row to the Fertilizer Nutrients box. 

 
• In the new row, enter the second nutrient in the Nutrient column and the 

percentage of that nutrient in the Percent % column. 
 

 
 

• Repeat the previous steps to add as many nutrients as needed. 
 

• If a nutrient is not in the drop down list, select <Add/Edit> to add it to the list. 
 

• Remove a nutrient from the analysis by selecting the remove button  to the left 
of the row for that nutrient. 
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• Farm Trac will enter the product weight conversion factor in the Product Weight 
for you. 

 

5. Select the  tab if you need to record re-entry restrictions for the supply. 
Re-entry Restrictions should be taken directly from the label. 

 
• Select the Re-entry Restrictions check box and enter the required number of 

hours in the Restricted-Entry Interval box. 
 

 
 

• In the PPE Required for Handlers and Early Entry PPE Required for 
Workers boxes, enter the required protective equipment for those handling the 
supply. 

 
• In the Other Label Requirements box, enter the other requirements for those 

handling the supply. 
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• If applicable, select the Treat Area Posting and Oral Notification Required 
check box. 

 
6. If there is a Pre-Harvest Interval restriction on the chemical, go to the  tab. 

 
• Select the crop from the drop down list or select <Add/Edit> if the crop isn’t 

listed. 
 

• Enter the Pre-Harvest Interval (in Days) in the second column. 
 

• If there are restrictions for more than one crop, press . 
 

 
 

7. When you have all of the desired information recorded for the supply, select OK (the 
supply will now appear in the Inputs box, under the appropriate Supply type—for 
example, a new fertilizer will appear under the Fertilizer/Lime icon).  
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View or modify the information for a supply at any time by right-clicking the name of the supply 
in the Inputs box and selecting Properties on the shortcut menu.  If you find you no longer need a 
supply, you can delete or retire it.  You cannot delete a supply that you used in a planned or 
completed farming operation—instead you must retire it.  To delete a supply you have not used 
in a planned or completed farming operation, right-click the supply’s name in the Inputs box and 
select Delete.  To retire a supply you have used in a planned or completed farming operation, 
right-click the supply’s name and select Retire.  When you retire a supply, Farm Trac will add an 
asterisk (*) to its name, or remove the supply from the Inputs box.  The program will still keep 
the retired supply’s farming history for future reference.  To display/hide retired employees in 
the Farm box, go to the View menu and select Show Retired Inputs. 
 
After you add your farms, fields, machines, people and supplies to the Farm Trac, you can begin 
recording planned and completed farming operations.  As stated previously, you do not have to 
draw or import maps of your fields before you enter your planned or completed tillage, spraying, 
seeding, or harvesting operations.  All you have to do is add the machines, people and supplies 
for the operation to the Working Group box and select the Apply to Fields button.  The next 
chapter will take you step-by-step through the process of recording planned and completed 
farming operations. 
 

Adding/Editing Commodities 
 
Commodities that are used in Farm Trac have properties tied to them that can be edited. Farm 
Trac has a long list of pre-entered commodities that can be chosen from. Commodities must be 
added to show up in lists as active. These changes are made under Commodity Properties. 
 
To edit Commodity Properties: 
 

1. Under the Resources menu, select Other and Commodities… 
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2. The commodities that are currently 
being used will be displayed in the 
Commodities box that appears. 

 
3. To add a commodity, press the 

 button and select the 
new commodity from the list or 
select <New> to add your own. 

 
4. To edit a commodities’ information, 

press the  button. 
 
 
  

 
5. After adding a new commodity name or when viewing the properties, the Commodities 

Properties box appears. Here you can enter/change any information about the commodity. 
 

 
 

• Units are the harvested units of the commodity 
 

• Density and moisture are used to calculate dry quantities when harvesting. 
Moisture should be the moisture that dry weight is calculated from. This 
information can be received from your local elevator or wherever you deliver 
your grain. 

 
• The value of the commodity is what will be used on Enterprise Statements when 

Farm Funds is not being used. This will be used to calculate profit/loss. 
 

• If Farm Site is installed, the Color will be the color shown on the map where that 
commodity is being grown. 
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Planning and Recording Jobs    

Planning and Recording Jobs 
After you add your fields and inputs to Farm Trac, you can begin entering farming operations 
(also called jobs). These consist of tillage, planting, spraying and harvesting operations to name a 
few.  To record a job, all you have to do is add the machines, people, and supplies for the job to 
the Working Group box, select the Apply to Fields button, and choose the fields where the 
operation was performed. You can also enter planned jobs showing the inputs you intend to use 
for each job which will enable you to print work orders to give to your workers in the field.  If 
you have Trac Mate installed on a handheld computer or the Titan RT, you can export the work 
orders for use in that program.  Planned jobs are also useful for generating cost-per-acre 
estimates for the upcoming crop year. This can be helpful when setting up a budget in Farm 
Funds or to just get an idea of supply costs for the year. 
 
When you or your workers complete a job, you can mark the planned job as complete in Farm 
Trac.  If you did not to enter a planned job for the work done in the field, you can record a 
completed job.  All of the planned and completed jobs you add to the program are conveniently 
listed in the Jobs box.  To help you find a job, you can sort the jobs in the Jobs box by field 
name, date, or other category. 
 
You will find information about how to synchronize work orders to Trac Mate and print work 
orders and other reports in other chapters of this reference guide.  This chapter describes how to 
record planned and completed jobs. 
 

Planning Jobs 
 
To create planned jobs, add all of the inputs (machinery, people, and supplies) you expect to use 
to the Working Group box. Select the Apply to Fields button, and then choose the field or fields 
for which you are planning the job.  Farm Trac displays the planned jobs in the Jobs box with 
orange text and icons of clipboards without checkmarks,  to help you see at a glance what 
farming operations are yet to be completed.  Once you finish the jobs, Farm Trac changes the 
text color to black and adds icons of clipboards with checkmarks  to the completed jobs. 
 
*When planning a job, all of the inputs, such as machinery and people, may not be known. In 
this case, only apply the inputs that are known and the others can be added when the job is 
complete. 
 
To record a planned job: 
 

1. Select the Inputs tab Å to view the Inputs box. 
 

2. In the Inputs box, choose each machine that you plan to use for the job. Open the tree to 
view the machines in each category by pressing the plus sign  next to the Machines 
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icon,  and opening the folder that the machine is under.  Add the machine to the 
Working Group by highlighting it and pressing the add button.  You can also double 
click the name of the machine. 

 
3. Choose the worker you intend to assign to the job by repeating the same process and 

adding them to the Working Group 
 

 
 

4. If applicable, add the supplies to the working group that you are likely to apply in the 
operation. Once again, open the tree to select the supply by pressing the plus sign  next 
to the Supplies icon  and open the applicable category to select the name of the supply 
to be used.Ç Select the add button  or double click on the supply name to add it to 
the Working Group box.É 

 
5. Repeat these steps to add as many machines, people and supplies as needed for the 

planned job. 
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6. To remove an input from the working group, highlight it in the Working Group box, and 
select the remove button.  To remove all inputs from the working group, select the 
remove all button.   

 
7. After you have all of the inputs you expect to use during the operation in the Working 

Group box, select the Apply to Fields button.Ñ 
 

8. In the Apply Working Group dialog box, select the plus sign  next to the farm  and 
select the field for which you are planning the job. Ö Press the add button  to 
add the field to the Fields to Apply box.Ü  You can also double click the name of the 
field to move it from one box to another. 

 

 
 

9. If the same operation is to be performed on more than one field, repeat the previous step 
to add additional fields to the Fields to Apply box. 

 
10. To remove a field from the planned job, select it in the Fields to Apply box and press the 

 button. All of the fields can be removed by pressing the  button. 
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11. Select the Record Planned Jobs button á to open the Farming dialog box. Notice the 
Orange highlighted boxes. This is to show you that the operation is a Planned Job and not 
a Completed Job. The Farming dialog box displays the general information for the 
planned job, followed by the information for each input. If more than one field was 
selected, the dialog box displays a separate column for each field. There will be “Total 
Column” to the left if there are multiple fields selected. Total values may be entered here 
and will be taken across each field by the proportion of the Area Farmed in each. 

 
12. If Site Pro is being used or if Farm Site is installed, you may also select the fields that the 

operation will be performed on in the  tab. To select multiple fields, hold down 
the shift key while selecting them.  After all of the fields have been selected, right click 
and select Apply Working Group to Planned… 

 

 
 

13. Enter the information for the planned job: 
 

• The field name and job type will be listed in the Job Name. You may rename the 
Job if desired. 

 
• To change the planned field name, select a field name button à in the Field 

Name row and select a different field in the Fields dialog box. 
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• To change the planned crop enterprise, select a different commodity and year in 
the Crop Enterprise list. Select <Add> to add a new crop enterprise to the list. 

 
• It is suggested to always assign a Crop Enterprise and not have the enterprise be 

“Field Prep” as was allowed in previous versions.  Crop enterprises never get 
closed and each operation can be edited at any time.  If the Enterprise changes 
throughout the year (plant a field to beans when it was planned to be corn) in a 
certain field, it can be edited under each individual job. 

 
• Crop Enterprises are a way to analyze a certain crop in a given year. There is a 

new enterprise for each year within a given crop. To compare records and 
profitability of one crop to another and one year to another, they must have 
separate enterprises.  For example, if a grower raises several types of one crop 
(soybeans and low linolenic soybeans) and wants to compare the two, they will all 
need to be under separate enterprises. 

 
• Select a Job Type for the operation. Job types are simply a way to sort through 

the many operations that take place throughout the year. These can be queried for 
reports and editing. 

 
• Enter/change the Console ID if applicable (Agco GTA users only). 

 
• The Area Farmed defaults to the tillable acres of the selected field. (If a partial 

operation was completed previously, it will default to the remaining tillable 
acres.)  During a planned operation, area farmed is usually not changed from the 
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tillable acres as actual applied acres will not be known until the job is complete. 
They may be changed if a partial operation is planned. The Area Farmed will 
carry to the charge units and applied area of the inputs below. 

 
• Enter the correct dates into the Start and Stop Date boxes. The calendar button 

 can also be used. Actual dates and times will generally not be known when 
planning a job. Enter in an approximation or simply leave these items blank. 

 
• Estimated Start and Stop Times may also be entered in the respective boxes. 

Farm Trac will calculate the Job Hours based off of these entries. The program 
will also fill these hours into the Charge Units (Hours) for any applicable inputs. 
If time is not known, estimate or leave these items blank. 

 
• To change the planned operator in charge of the operation, select a different 

person in the Operator list, or select <Add> to add a new operator. 
 

14. Enter the information for each of the inputs: 
 

• Any of the inputs may be removed from the planned operation by pressing the 
 button next to it. 

 
• Inputs may also be added while in the Farming dialog box by selecting the Add 

Input menu item and selecting the input from the Resources dialog box. 
 

 
 

• If a Person was used in the planned operation, the Charge Units (hours) will be 
filled in automatically from the Job Hours calculated above. The Cost ($/hour) 
of the worker defaults to the cost entered in the person’s properties. Both of these 
values may be modified here, if necessary. 

 
• Any machinery used in the operation will be under the Personnel.  Once again, the 

Charge Units and Cost of the machinery will come from the Area Farmed and 
the machine’s properties (entered when adding machinery) respectively. If the 
machinery uses fuel, the estimated Fuel Used as well as the Fuel Cost will 
display as well. Any of these values may be edited here. 
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• After the machinery, all of the supplies that are planned to be used are listed. If 
the supply is going to be applied using Variable Rate Application, check the 
corresponding box.  This will allow you to create a variable rate prescription map 
for this supply.  Variable Rate Application will be covered in the Farm Site 
manual. 

 
• Select the machine that will be applying the supply and if needed, edit the 

Applied Area, Planned Rate, or Cost of the supply. The Planned Rate and 
Cost of the supplies are the values that were entered when the supply was setup.  
Quantity Used is calculated from the Applied Area and Planned Rate. 
Changing the Quantity Used will also change the Planned Rate and vice versa. 

 
• If applicable, select a 

Chemical Carrier and 
enter a Carrier Rate for 
each Chemical. 

 
• If a supply is an 

insecticide, herbicide, or 
other pest-control 
chemical, you can select 
the  button 
and choose the pests that 
the chemical controls 
(you can choose up to 
five pests for each 
chemical). 

 

 
 

 
15. Save the planned job by selecting OK, or select Cancel to close the Farming dialog box 

without saving the planned job. Farm Trac adds the planned job you saved to the Jobs 
box, where it has orange-color text and an icon of a clipboard without a checkmark.  If 
you selected more than one field, the program adds a separate planned job for each field 
to the Jobs box. 

 

Completing Planned Jobs 
 
After you create your planned jobs (also called planned farming operations), Farm Trac allows 
you to make changes to the planned jobs as often as you like before you assign the jobs to your 
workers.  All you have to do is select the planned jobs in the Jobs box and re-open the Farming 
dialog box to make the modifications you want.  When you have the plans for the job entered to 
your satisfaction, you can then print planned job reports to give to your workers, or you can mark 
the jobs for export to Trac Mate so your workers can use the work orders on a handheld 
computer or the Titan RT out in the field. 
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After you print or export work orders, you can easily mark a job as complete with just two clicks 
of your mouse. See the next chapters of this reference guide for instructions on editing planned 
jobs, printing work orders, and exporting work orders to Trac Mate. This section explains how to 
complete planned jobs. To locate a planned job and mark it as complete: 
 

1. Find the planned job you that want to mark as complete in the Jobs box: 
 

• Select the Jobs tab.   
 

• In the Jobs box, jobs can be sorted by selecting the appropriate column header, 
such as the Date or Field column header. 

 

 
 

• Select a column header a second time to reverse the sort order. 
 

• If necessary, scroll up  or down  through the farming operations to find the 
job you wish to complete. Remember, planned jobs are listed in orange and have a 
clipboard with no checkmark.  

 
• If there is a long list in the Jobs tab and you are having a problem finding the 

correct operation, you can use a filter to only display certain jobs. 
 

§ Press the  button at the bottom of the  tab. You can 
now use the Job Filter to narrow the jobs listed by any of the following 
parameters: Date Range, Farm/Field, Crop Year, Commodity, Job Type, 
Operator, Console, Input, or Status. 

 
§ For example, if the job that needs to be completed is a corn enterprise, 

check the box beside Commodity and select Corn. Since we know this job 
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is a planned job, Status can also be checked and Planned can be selected. 
Press OK to apply the Filter. 

 

§ To show all of the jobs in the  tab once again, simply press the 

 button at the bottom of the screen. 
 

 
 

2. After locating the planned job that you want to complete in the Jobs box, you may want 
to verify this is the correct operation. 

 
• Right-click the job and select Properties on the shortcut menu. 

 
- or - 
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Select the job to highlight it and select the  button at the bottom of the 
Jobs box. 
 

 
 

• In the Farming dialog box that opens, examine the information to verify it is the 
correct job (This is the same information that was entered when the Planned job 
was created.) 

 
3. You may now complete the planned job. 

 
• Right-click the job and select Complete on the shortcut menu. 

 
- or - 
 

Select the job to highlight it and select the  button at the bottom of the 
Jobs box. 
 



Farm Trac Reference Guide 

73 

 
 

• You may now make any changes to the operation in the Farming dialog box that 
opens. Notice the orange highlighted boxes are now grey. This is to show you that 
the operation will now be a Completed Job and not a Planned Job. Fill in any 
information that was not known when the job was planned and correct any 
information that may have changed. 

 
• Select OK to complete the job. Farm Trac will now indicate it is completed by 

changing the text color of the job from orange to black and placing a checkmark 
on the clipboard.  

 
• Select Cancel rather than OK if you decide not to complete the job. Farm Trac 

will continue to display the job as a planned job with orange-color text and a 
clipboard without a checkmark.  

 
Once you mark a job as complete, you cannot change it back to a planned job; however, you can 
make changes to the completed job as needed.  You can also delete a completed job and reenter 
it as a planned job.  For explanations on editing and deleting jobs, see the appropriate chapter of 
this reference guide. 
 

Recording Tillage Operations 
 
Rather than recording planned farming operations and then marking them as complete, you can 
just record completed farming operations (also called completed jobs).  To record a tillage 
farming operation, add all of the used inputs (people, machinery, supplies) to the working group 
and then select the Apply to Fields button.  Before you save the tillage operation, complete the 
details of the job in the Farming dialog box.  Farm Trac adds the completed tillage operation to 
the Jobs box where it has black text and an icon of a clipboard with a checkmark.  
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To record a tillage operation: 
 

1. Add the machinery to the Working Group: 
 

• Select the Inputs tab.   
 

• Find the machinery that will be used in the operation within the tree by selecting 
the plus sign  to open each category. 

 
• Select each machine and press the add button  to add it to the Working 

Group box. Double clicking on the machine name will also add it to the 
Working Group. 

 
• To remove a machine from the working group, select a machine in the Working 

Group box and select the remove button  or double click on the machine 
name. To remove all inputs from the working group, select the remove all button. 

 
 

2. Add the worker to the Working Group box: 
 

• Select the plus sign  next to the People icon  to see the workers that have been 
added to Farm Trac. 

 
• Select the worker who performed the tillage operation and add them to the 

Working Group box by selecting the add button  or double clicking their 
name. 

 
• Repeat the previous steps to add any additional workers to the operation. 

 
3. After all of the inputs have been added to the Working Group, select the Apply to 

Fields button. 
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4. In the Apply Working Group dialog box, select the field or fields that the tillage 
operation was performed in: 

 
• In the Fields box, select the plus sign  next to the icon of the farm  that the 

field is located in. 
 

• Select the icon for the appropriate field  and select the add field button 
 to add the field to the Fields to Apply box. You can also double click 

the name of the field to add or remove it from the Fields to Apply box. 
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• Repeat these steps to add any additional fields to the tillage operation. 
 

• To remove a field from the tillage operation, select the remove button  
or remove all fields from the Fields to Apply box by selecting the remove all 
button.  

 
• Select the  button to open the Farming dialog 

box. 
 

5. In the Farming dialog box, enter the details about the tillage operation: 
 

• If multiple fields were selected, there will be a separate column for each field with 
a Total Column on the left. If items are entered into the total column, they will 
carry through to all fields selected. If quantities are entered in the total column, 
they will get distributed to each field by proportion of total area farmed. 
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• General information for the 
tillage operation is listed, 
followed by specific 
information for each input. 
Weather and field condition 
information is also included 
for every farming operation. 
You may need to scroll up 
and down to see all of the 
items listed for the operation. 

 
• If the wrong field was 

selected, select the Field 
Name button and choose a 
different field in the Fields 
dialog box. 

 
• The Crop Enterprise box 

will be blank if you have not 
previously chosen a crop 
enterprise for the field. Select 
the crop you intend to plant 
in the field and the correct 
crop year. If the correct crop 
enterprise is not listed, select 
<Add> to add the new 
enterprise. 

 
• Unlike in past versions, it is 

best to select a crop 
enterprise even if you are 
unsure of the crop. This can 
be edited at any time. 

 
 

 
• The field name and job type will be listed in the Job Name. You may rename the 

Job if desired. 
 

• If a machine from the Land Preparation folder was chosen, Land Preparation 
will be the listed Job Type. Job Type is a simple way of sorting operations. Jobs 
can be queried by this, so it is important to have the correct type selected. 

 
• The Area Farmed box displays the tillable acres for each field. If a partial tillage 

operation was performed previously, the remaining acres will be shown here. If 
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the entire field was not farmed, enter the covered acres. Farm Trac carries this 
value to the charge units for any inputs that charge by the acre. 

 
• The Start Date and Stop Date boxes display the current working date for Farm 

Trac. If the operation was completed on a different date, enter it here. The 
operation may also be completed over more than one day. 

 
• Enter the appropriate Start and Stop Times for the operation. Farm Trac will 

automatically calculate and display the total hours in the Job Hours box. These 
hours will be carried to any inputs that have hours as their Charge Units. Job 
Hours and Charge Units can be edited and do not have to match the start and 
stop times. 

 
• The Operator is the person that was added to the Working Group. If more than 

one operator was selected, you must choose only one Operator for each field. 
You can select an operator from the list, or select <Add> to add a new one. The 

operator is another way that jobs can be queried or sorted in the  tab. 
 

• If necessary, you can change the Charge Units and Cost for any workers in the 
operation.  If Farm Funds is installed, Cost will not be in the list as it will come 
directly from the employee’s payroll. 

 
• For any of the machines used in the operation, you can change the Charge Units, 

Cost, Fuel Used, and Fuel Cost items.  Once again, Cost and Fuel Cost will only 
display if Farm Funds is not installed. These items will be explained further in the 
Farm Funds manual. 

 
• Any of the inputs may be removed from the operation by pressing the 

 button next to it. 
 

• Inputs may also be 
added while in the 
Farming dialog box by 
selecting the Add Input 
menu item and then 
selecting the input from 
the Resources dialog 
box. 

 
 

 
• To record weather information, select values in the Sky Conditions and Wind 

Direction lists, and enter the appropriate numbers in the Wind Speed, Gusting 
To, Temperature and Relative Humidity % boxes. 
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6. Once all of the information is entered into the Farming dialog box, select OK to save the 
tillage operation. Farm Trac adds the completed operation to the Jobs box with black text 
and an icon of a clipboard with a checkmark for every field that the operation was 
performed.   

 

 
 

7. If no more operations are to be performed using the current inputs, remove the, from the 
Working Group dialog box by selecting the remove all button.   

 

Recording Planting Operations 
 
To record a planting farming operation, add all of the inputs that were used to the working group, 
select the Apply to Fields button, and choose the field or fields to which you want to apply the 
inputs. Before you save the planting operation, enter all of the details from the job in the Farming 
dialog box.  Farm Trac will add the completed planting operation to the Jobs box where it will 
have black text and an icon of a clipboard with a checkmark.   
 
To record a planting operation: 
 

1. Add the planting equipment to the Working Group: 
 

• Select the Inputs tab.   
 

• Find the machinery that will be used in the operation within the tree by selecting 
the plus sign  to open each category. 

 
• Select each machine and press the add button  to add the machine to the 

Working Group. Double clicking on the machine name will also add it to the 
Working Group. 
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• To remove a machine from the working group, select a machine in the Working 
Group box and select the remove button,  or double click on the machine 
name.  To remove all inputs from the working group, press the remove all button. 

 
 

2. Add the worker to the Working Group dialog box: 
 

• Select the plus sign  next to the People icon  to see the workers that have been 
added to Farm Trac. 

 
• Select the worker who performed the planting job and select the add button  or 

double click their name, to add the worker to the Working Group. 
 

• Repeat the previous step to add additional workers to the operation. 
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3. Add the supplies to the Working 
Group: 

 
• Select the plus sign  next to 

the Supplies icon to open the 
supply tree. Select the 
supplies used from each 
supply category and add them 
to the Working Group as 
you did the machinery and 
people. 

 
• After all of the inputs have 

been added to the Working 
Group, select the Apply to 
Fields button 
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4. In the Apply Working Group dialog box, select the field or fields where the working 

group performed the planting operation: 
 

• In the Fields box, select the plus sign  next to the icon of the farm  that the 
field is located in. 

 
• Select the icon for the appropriate field  and select the add field button 

 to add the field to the Fields to Apply box. You can also double click 
the name of the field to add or remove it from the Fields to Apply box. 

 
• Repeat these steps to add any additional fields to the planting operation. 

 
• To remove a field from the planting operation, select the remove button 

 or remove all fields from the Fields to Apply box by selecting the 
remove all button.  

 

• Select the  button to open the Farming dialog 
box. 

 
5. In the Farming dialog box, enter the details about the planting operation: 

 
• If multiple fields were selected, there will be a separate column for each field with 

a Total Column on the left. If items are entered into the total column, they will 
carry through to all fields selected. If quantities are entered in the total column, 
they will get distributed to each field by proportion of total area farmed. 

 
• General information for the planting operation is listed, followed by specific 

information for each input. Weather and field condition information is also 
included for every farming operation. You may need to scroll up and down to see 
all of the items listed for the operation. 

 
• If the wrong field was selected, select the Field Name button and choose a 

different field in the Fields dialog box. 
 

• The Crop Enterprise box will be blank if you have not previously chosen a crop 
enterprise for the field. Select the crop you are planting in the field and the correct 
crop year. If the correct crop enterprise is not listed, select <Add> to add the new 
enterprise. 

 
• The field name and job type will be listed in the Job Name. You may rename the 

Job if desired. 
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• If a machine from the Planting/Seeding folder was chosen, Planting/Seeding will 
be the listed Job Type. Job Type is a simple way of sorting operations. Jobs can 
be queried by this, so it is important to have the correct type selected. 

 
• The Area Farmed box displays the tillable acres for each field. If a partial 

planting operation was performed previously, the remaining acres will be shown 
here. If the entire field was not farmed, enter the covered acres. Farm Trac carries 
this value to the charge units for any inputs that charge by the acre as well as 
Applied Areas. 

 
• The Start Date and Stop Date boxes display the current working date for Farm 

Trac. If the operation was completed on a different date, enter it here. The 
operation may also be completed over more than one day. 

 
• Enter the appropriate Start and Stop Times for the operation. Farm Trac will 

automatically calculate and display the total hours in the Job Hours box. These 
hours will be carried to any inputs that have hours as their Charge Units. Job 
Hours and Charge Units can be edited and do not have to match the start and 
stop times. 

 
• The Operator is the person that was added to the Working Group. If more than 

one operator was selected, you must choose only one Operator for each field. 
You can select an operator from the list, or select <Add> to add a new one. The 

operator is another way that jobs can be queried or sorted in the  tab. 
 

• If necessary, you can change the Charge Units and Cost for any workers in the 
operation.  If Farm Funds is installed, Cost will not be in the list as it will come 
directly from the employee’s payroll. 

 
• For any of the machines used in the operation, you can change the Charge Units, 

Cost, Fuel Used, and Fuel Cost items.  Once again, Cost and Fuel Cost will only 
display if Farm Funds is not installed. These items will be explained further in the 
Farm Funds manual. 

 
• For the supplies used in the operation, select the Machine that applied them. 

Applied Area is filled in from the Area Farmed. Planned Rate defaults to the 
rate specified when setting up the supply.  You may change it as needed. Qty. 
Used gets calculated from the Area Farmed and the Planned Rate. If actual 
amounts are different than this, enter them here and Actual Rate will reflect the 
new value. Cost of each supply is from the value entered when setting up the 
supply. This can be edited if needed. Again, Cost for a supply will not show up if 
Farm Funds is installed. 

 
• For restricted-use supplies, you can select a carrier in the Chemical Carrier list 

and enter a rate in the Carrier Rate box. 
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• For herbicides, insecticides and other pest-control supplies, you can select the 

Pests Controlled button to choose the applicable pests. If pests were selected 
when entering the supply, they will already be chosen here. 

 
• Any of the inputs may be removed from the operation by pressing the 

 button next to it. 
 

• Inputs may also be added while in the Farming dialog box by selecting the Add 
Input menu item and then selecting the input from the Resources dialog box. 

 
• To record weather information, select values in the Sky Conditions and Wind 

Direction lists, and enter the appropriate numbers in the Wind Speed, Gusting 
To, Temperature and Relative Humidity % boxes. (optional) 

 
• To record field conditions, select the applicable values in the Growth Stage, 

Application Method, Soil Condition and Soil Type lists, or select <Add/Edit> 
to add any new values. (optional) 
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6. Once all of the information is entered into the Farming dialog box, select OK to save the 
planting operation. Farm Trac adds the completed operation to the Jobs box with black 
text and an icon of a clipboard with a checkmark for every field that the operation was 
performed.   

 
7. If no more operations are to be performed using the current inputs, remove the, from the 

Working Group dialog box by selecting the remove all button.   
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Recording Harvest Operations 
 
To record a harvest farming operation, add all of the inputs (labor, machinery, etc) to the 
working group and select the Apply to Fields button.  Before you save the harvest operation, 
enter all of the details from the harvest into the Farming dialog box.  Farm Trac will add the 
completed harvest operation to the Jobs box where it will have black text and an icon of a 
clipboard with a checkmark.  
 
To record a harvest operation: 
 

1. Add the harvest equipment to the Working Group: 
 

• Select the Inputs tab.   
 

• Find the machinery that will be used in the operation within the tree by selecting 
the plus sign  to open each category. (Combines, headers, grain trucks, etc.) 
 

• Select each machine and press the add button  to add the machine to the 
Working Group. Double clicking on the machine name will also add it to the 
Working Group. 
 

• To remove a machine from the working group, select a machine in the Working 
Group box and select the remove button,  or double click on the machine 
name.  To remove all inputs from the working group, press the remove all button. 
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2. Add the worker to the Working 
Group dialog box 

 
• Select the plus sign  next to the 

People icon  to see the workers 
that have been added to Farm Trac. 

 
• Select the worker who performed the 

harvest job and select the add button 
 or double click their name, to 

add the worker to the Working 
Group. 

 
• Repeat the previous step to add 

additional workers to the working 
group. 

 
3. After you have all the inputs you 

want added to the Working Group 
box, select the Apply to Fields 
button. 
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4. In the Apply Working Group dialog box, select the field or fields where the working 

group performed the harvest operation: 
 

 
 

• In the Fields box, select the plus sign  next to the icon of the farm  that the 
field is located in. 

 
• Select the icon for the appropriate field  and select the add field button 

 to add the field to the Fields to Apply box. You can also double click 
the name of the field to add or remove it from the Fields to Apply box. 

 
• Repeat these steps to add any additional fields to the harvest operation. 

 
• To remove a field from the planting operation, select the remove button 

 or remove all fields from the Fields to Apply box by selecting the 
remove all button.  

 

• Select the  button to open the Farming dialog 
box. 
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5. In the Farming dialog box, enter all of the details about the harvest operation. 
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• If multiple fields were selected, there will be a separate column for each field with 
a Total Column on the left. If items are entered into the total column, they will 
carry through to all fields selected. If quantities are entered in the total column, 
they will get distributed to each field by proportion of total area farmed. 

 
• General information for the planting operation is listed, followed by specific 

information for each input. Weather and field condition information is also 
included for every farming operation. You may need to scroll up and down to see 
all of the items listed for the operation. 

 
• If the wrong field was selected, select the Field Name button and choose a 

different field in the Fields dialog box. 
 

• The Crop Enterprise list displays the year and commodity you chose during a 
previous farming operation. This should be correct; however, you can change it 
here if needed. If the enterprise is not listed, select <Add> to add the new 
enterprise to the list. 

 
• The field name and job type will be listed in the Job Name. You may rename the 

Job if desired. 
 

• If a machine from the Harvesting folder was chosen, Harvesting will be the listed 
Job Type. Job Type is a simple way of sorting operations. Jobs can be queried by 
this, so it is important to have the correct type selected. 

 
• The Area Farmed box displays the tillable acres for each field. If a partial 

harvest operation was performed previously, the remaining acres will be shown 
here. If the entire field was not farmed, enter the covered acres. Farm Trac carries 
this value to the charge units for any inputs that charge by the acre. 

 
• The Start Date and Stop Date boxes display the current working date for Farm 

Trac. If the operation was completed on a different date, enter it here. The 
operation may also be completed over more than one day. 

 
• Enter the appropriate Start and Stop Times for the operation. Farm Trac will 

automatically calculate and display the total hours in the Job Hours box. These 
hours will be carried to any inputs that have hours as their Charge Units. Job 
Hours and Charge Units can be edited and do not have to match the start and 
stop times. 

 
• The Operator is the person that was added to the Working Group. If more than 

one operator was selected, you must choose only one Operator for each field. 
You can select an operator from the list, or select <Add> to add a new one. The 

operator is another way that jobs can be queried or sorted in the  tab. 
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• If necessary, you can change the Charge Units and Cost for any workers in the 
operation.  If Farm Funds is installed, Cost will not be in the list as it will come 
directly from the employee’s payroll. 

 
• For any of the machines used in the operation, you can change the Charge Units, 

Cost, Fuel Used, and Fuel Cost items.  Once again, Cost and Fuel Cost will only 
display if Farm Funds is not installed. These items will be explained further in the 
Farm Funds manual. 

 
• To add a new input to the harvest job (such as another machine or person) select 

Input on the Add menu, and select the input you want to add in the Resources 
dialog box that opens and select OK. 

 
• Any of the inputs may be removed from the operation by pressing the 

 button next to it. 
 

• Inputs may also be added while in the Farming dialog box by selecting the Add 
Input menu item and then selecting the input from the Resources dialog box. 

 
• If scale tickets are available, press the  button. To learn how to 

enter scale tickets, see the appropriate section in this manual. 
 

• If Farm Funds is installed, select the Harvest Destination. See the Farm Funds 
manual for further explanation. 

 
• Under harvest information, enter the Yield/Ac or Qty. Harvested and Farm 

Trac will calculate the other one based off of the Area Farmed. Enter the 
Harvest Unit Cost (will not be present if Farm Funds is installed). 

 
• To record weather information, select values in the Sky Conditions and Wind 

Direction lists, and enter the appropriate numbers in the Wind Speed, Gusting 
To, Temperature and Relative Humidity % boxes. (optional) 

 
• To record field conditions, select the applicable values in the Growth Stage, 

Application Method, Soil Condition and Soil Type lists, or select <Add/Edit> 
to add any new values. (optional) 

 
6. Once all of the information is entered into the Farming dialog box, select OK to save the 

harvest operation. Farm Trac adds the completed operation to the Jobs box with black 
text and an icon of a clipboard with a checkmark for every field that the operation was 
performed.   
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7. If no more operations are to be performed using the current inputs, remove the, from the 
Working Group dialog box by selecting the remove all button.   

 

Entering Scale Tickets 
 
When entering a harvest operation, scale tickets can be entered into Farm Trac. This can be an 
easy way of calculating yield, plus allows you to keep these records and print scale ticket reports. 
Scale ticket information will be transferred to Qty. Harvested and Yield/ac in the Farming 
dialog box. Many times at harvest, these tickets aren’t available yet. When initially entering the 
harvest operation, an estimate can be entered into the Qty. Harvested and Yield/ac. When scale 
tickets are available, they can then be entered and that information will override any previously 
entered values. 
 

1. Press the  button under Harvest Information in the farming dialog box 
when entering a harvest operation. 

 
2. Select the Commodity in the drop down list or select <Add/Edit> if it is not listed. 

 
3. Enter the Dry Moisture, Lbs/bushel and Shrink values into the appropriate boxes. This 

information should be available from your local elevator or wherever you deliver you 
grain. When you enter in the ticket information, Farm Trac will use these numbers to 
calculate the Qty. (Dry) 
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4. Enter the Load ID (ticket number), Gross Wt., Tare Wt., % Moisture, and % FM from 
the scale ticket. 

 

5. Press the  button to add as many rows as needed. 
 

6. Once all of the ticket information is entered, press the  button and Farm 
Trac will calculate Net Wt., Qty. (Wet), Qty. (Dry), and the Totals row. 

 
7. Under the File menu, a simple scale ticket report can be printed. 

 
8. Press OK and the Total Qty. (Dry) will be entered into the Qty. Harvested in the 

farming dialog box. 
 

Editing Landlord/Sharecrop Information when Completing a Job 
 
Fields that are sharecropped will have a special line item in the farming dialog box. The 
Landlords button will show beside Sharecrop Information allowing you to modify any 
charges, receipts, and inputs for a landlord. 
 
To edit Landlord information while performing a farming operation (sharecropped fields only): 
 

1. In the Farming dialog box, press the  button. 
 

2. The  tab of the Field Properties box will appear. 
 

3. Add/modify any information for Harvest/Input charges and percentages as well as 
Equipment charges, if applicable. 

 
4. You can also Add and Remove Landlords from the sharecrop information on the field. 

 
5. For more information on landlord properties, see the Setting up Fields section of this 

manual. 
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Changing the Working Date 
 
When using Farm Trac, you may temporarily change the working date within the program. This 
can be helpful if you are entering multiple operations that occurred on the same date. Changing 
the working date prevents you from having to enter the correct date for every operation. To 
temporarily change the working date: 
 

1. Select the working date in the upper, right-hand corner of the program to open the 
Working Date dialog box. 

 

 
 

2. In the Working Date dialog box, the date that your computer’s operating system is using 
is in the System Date box, and the date the program is using in the Working Date box. 
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3. Enter the date you want the program to use in the Working Date box by either typing the 
new date in the box, or selecting the calendar button.  Choose the appropriate date in 
the calendar that appears. If necessary use the left spinner button  or right spinner 
button  to change the calendar month. 

 

 
 

4. The Working Date dialog box displays the new selected date. Press OK to accept the 
working date change. 

 
5. If you select OK, Farm Trac displays the working date you chose in the upper, right-hand 

corner of the program, and will use this date until you change it. Restarting the program 
will also set the Working Date back to the System Date. 

 

 
 

6. When finished with the work on previous date, do not forget to change the Working 
Date back to match the System Date. Operations can easily be performed on the 
incorrect date if this is not done. The System Date is the date that your computer is set to. 

 
There are times that changes need to be made to planned and completed farming operations. The 
next chapter covers editing and removing farming operations.



Modifying and Managing Jobs     

Modifying and Managing Jobs 
After you record planned and completed jobs (farming operations) with Farm Trac, it is easy to manage 

and modify the jobs.  You can manage jobs in either the Farm box  or the Jobs box.  
To locate a job in the Farm box, you must first select Show Jobs in Land Areas on the View menu. Then 
all you have to do is select the Farm tab and open the tree under a farm to view a job that has been 
recorded. To find a job in the Jobs box, select the Jobs tab and use the sorting and filtering features of 
Farm Trac to display only the jobs that meet the criteria of the job for which you are searching. 
 
Once you locate a job, you can modify the operation by right-clicking it and selecting Properties on the 
shortcut menu. This opens the Farming dialog box where you can change any of the details of the 
farming operation.  Use the Farming dialog box to delete or add inputs such as machinery, people and 
supplies.  You can change the dates of the farming operation, the number of acres farmed, and even the 
field in which the operation took place. Jobs can also be deleted by right-clicking the job and selecting 
Delete on the shortcut menu. 
 

Using the Jobs Tab 
 

When you select the  tab of Farm Trac, all of the planned and completed jobs you have 
entered, synchronized, or imported into the program will be listed.  The Jobs box has a separate row for 
each job and displays planned jobs with orange-color text and an icon of a clipboard without a 
checkmark.  Completed jobs are listed with black text and a clipboard with a checkmark.   In the 
Jobs box, there are several columns, including the Job Name, Date, Field, Year, Commodity, Type, 
Operator and other columns, under which you will see the specific information for each job.  Jobs can be 
sorted by these columns headers. 
 
To find a specific job in the Jobs box: 
 

1. Select the  tab to see all planned and completed jobs. 
 

2. To sort the jobs listed, select a column header of the Jobs box.  For example, select the Field 
column header to sort the jobs by field name, or select the Date column header to sort the jobs by 
date and display the most recent jobs first. 
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3. To reverse the order of the jobs, select a column header a second time (for example, select the 
Date column header a second time to display the oldest jobs first). 

 
4. To widen or narrow a column, move your cursor over the space between the column header you 

want to widen or narrow so that the cursor changes to one with two arrows.    Hold the left 
mouse button down as you drag your mouse to the left or right to adjust the column width. 

 
5. If it is difficult to find the job you are looking for because the Jobs box is cluttered, use the filter 

to display only certain jobs. To view the jobs for only one farm or field: 
 

• Select the Farm tab.  
 

• Select the plus sign  next to the icon of the farm  for the jobs you want to display. 
(Farm Trac highlights the farm and displays the fields of that farm in the Farm box). 

 
• Select the Filter Jobs by Farm check box at the top of the Farm box to display only the 

jobs for that farm in the Jobs box. 
 

• Select a specific field icon  in the Farm box, and Farm Trac shows only the operations 
for that field in the Jobs box. 
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• To remove the filter, clear the Filter Jobs by Farm check box, and Farm Trac displays 
all of the jobs for all of the fields in the Jobs box once again. 

 
6. To filter jobs by a specific machine, person, or supply: 

 

• Select the Inputs tab.   
 

• Select the plus sign  next to the appropriate category and select the item you want to 
filter by. 

 
• After choosing the input, select the Filter Jobs by Input check box to have the Jobs box 

show only the jobs including the use of that input. 
 

 
 

• Clear the Filter Jobs by Input check box to have the Jobs box display all jobs once 
again. 
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7. To filter jobs by a date range, or by other criteria, select the  button at the bottom of 
the Jobs box to open the Job Filter dialog box. Select the check boxes for each property you 
want to add to the filter. Jobs can be filtered by more than one criteria. 

 
• To filter jobs by a particular date range, select the Date Range check box and enter the 

desired dates in the From and To boxes. 
 

• To filter jobs by any of the other criteria, select the check boxes beside the property and 
enter or select the values to filter. 

 

 
 

• To remove criteria from the job filter, clear their check boxes. 
 

• Apply the job filter by selecting OK, and the Jobs box now displays only the jobs that 
meet the criteria of the filter you created. 
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• Edit the items filtered by selecting the  button again and follow the previous 
steps. 

 

• Remove the filter by selecting the  button, and Farm Trac will display all 
jobs in the Jobs box once again. 

 
• It is possible to apply a filter that doesn’t show any jobs in the list. If the job list is ever 

blank, just press the  button to show all of the jobs again. 
 

8. Other tasks can be performed with the buttons at the bottom of the Jobs box: 

  

Each of these tasks can also be performed by right clicking on a job in the jobs list. 

• If one operation got entered as two or more different jobs, you can merge the operations 
together. The jobs to be merged together have to be of the same Type and in the same 

Field. To merge jobs together, highlight all of them in the  tab by holding the 

Ctrl key and press the  button. The multiple entries in the jobs list will now 
only be listed as one. If you right click on the new job, it will list a separate column for 
each job that was merged together as well as a total column. 

• Select the  button to print job reports for a highlighted job. See the printing 
section of this manual for more information. 

• The  button can be used to complete a planned job. See Completing Planned 
Jobs in this manual for further explanation. 
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• The  button allows you to export an .xml file of a job. If a map (VRA, yield 
map, etc) is tied to the job, a shape file or .csv file can be exported as well. 

• Use the  button to delete a job. Once removed, a job cannot be recovered. 

• The  button allows you to view or edit the details of a job. 

Using the View Menu 
 

Use the View menu of Farm Trac to set your viewing preferences for the Farm  and Input  
boxes.  The View menu allows you to show or hide items in the Farm box, such as retired land areas, or 
planned and completed jobs.  Items in the Inputs box can also be hidden, such as machines, people, or 
supplies.  If you have Farm Site installed with Farm Trac, you can use the View menu to show or hide 
background images, such as aerial photos to display with maps of your fields. 
 
To show or hide items in the Farm and Inputs boxes: 
 

1. Checkmarks beside items in the View menu indicate which items are displayed and which are 
hidden. 
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2. To show retired inputs, select the 

Inputs tab  and select Show 
Retired Inputs on the View menu. 
Farm Trac places a checkmark 
beside the menu item and displays 
the retired inputs with an asterisk (*) 
beside them. To hide the retired 
inputs again, simply remove the 
checkmark beside Show Retired 
Inputs. 

 
3. To put an input back into use and out 

of retirement, place a checkmark 
beside Show Retired Inputs on the 
View menu, right click the retired 
input, and select Un-Retire on the 
shortcut menu. This will remove the 
asterisk from the input’s name. 

 
 

4. To show retired farms and fields, select the Farm tab  and select Show Retired 
Land Areas on the View menu. Farm Trac places a checkmark beside the menu item and 
displays the retired land areas with an asterisk (*) beside them. To hide the retired land 
areas again, simply remove the checkmark beside Show Retired Land Areas. 

 
5. To put an farm or field back into use and out of retirement, place a checkmark beside 

Show Retired Land Areas on the View menu, right click the retired farm or field, and 
select Un-Retire on the shortcut menu. This will remove the asterisk from the farm or 
field’s name. 

 
6. To show planned and completed jobs in the Farm box, select Show Jobs in Land Areas 

on the View menu. Farm Trac displays the jobs under the applicable farm,  field,  
and crop enterprise icons  in the Farm box. Hide the jobs in the Farm box by 
removing the checkmark beside Show Jobs in Land Areas on the View menu. 
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7. If Farm Site is installed together with Farm Trac, you can select Show Backgrounds in 
Land Areas on the View menu to display background image icons in the Farm box. 
Farm Trac adds a background image icon  to the Farm box for each background image 
that has been imported into the program. To display this image, double click on the image 
name or icon.  This will be covered further in the Farm Site manual. Remove the 
checkmark beside Show Backgrounds in Land Areas to hide the image icons and aerial 
photograph names. 

 

Editing Jobs 
 
You can edit a farming operation in Farm Trac at any time. First, find the operation or job in the 
Jobs or Farm boxes. You can then modify the job by viewing the Job Properties. Planned and 
completed jobs can be modified in this manner. 
 
To edit a farming operation: 
 

1. Find the farming operation under either the  tab or the  tab. Filters and 
sorting can be used to assist in finding the jobs (see Using the Jobs Tab section). 

 
2. Right click on the farming operation you want to modify and select Job Properties on 

the shortcut menu. Under the Jobs tab, you can also select the  button after 
highlighting the job. 

 
3. The farming dialog box will appear for the operation. Here you can make any 

modifications as well as add or remove any necessary inputs. 
 

• To add an input, select Input 
on the Add menu. Select the 
machine, person, or supply 
you wish to add to the 
operation in the Resources 
dialog box that appears and 
press OK. 

 
 



Farm Trac Reference Guide 

104 

• Remove an input from the 
operation by pressing the 

 button next to 
the input name. 

 
• You can also change the 

Field Name, Crop 
Enterprise, Job Type, and 
any other information 
displayed in the farming 
dialog box. Areas, times, 
quantities, units, operators, 
and field/weather information 
can all be modified. 

 

 
 

• Make these changes just as you would enter a new operation. (See the recording 
operations sections for more information.) 

 
• Farming operations can be modified as often as needed. 

 

Removing/Deleting Jobs 
 
At any time you can delete planned or completed farming operations. Deleting farming 
operations permanently removes them from Farm Trac, replaces any inventories (Farm Funds 
only), and subtracts any charge units when inputs were used. 
 
To delete a farming operation: 
 

1. Find the farming operation under either the  tab or the  tab. Filters and 
sorting can be used to assist in finding the jobs (see Using the Jobs Tab section). 

 
2. Verify the operation is the one that needs removed by right clicking on the job and 

selecting Properties on the shortcut menu. This will display all of the entered 
information about the operation. 
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3. Once it is determined the operation needs deleted, right click on the Job name and select 
Delete. You can also highlight the job name under the Jobs tab and press the 

 button at the bottom of the screen. 
 

 
 

4. Several operations can be removed at one time by holding the Ctrl key and selecting each 

operation under the  tab. Once they are all highlighted, press the 
 button at the bottom of the screen. 

 
5. Once a job is deleted, the records are PERMANENTLY removed from Farm Trac. 

 

Editing Enterprise Properties 
 
Information about an enterprise can be edited to show different information on Enterprise 
Statements and other reports. Area, Plant Dates, and Harvest Dates can all be edited. Area will be 
the amount of tillable acres specified when the field was set up.  Plant Date and Harvest Date 
will be automatically entered when farming operations are completed. These dates can be 
modified here if necessary. 
 
To edit Enterprise Properties: 
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1. Under the View menu, select Enterprise Properties… 
 

2. All enterprises will be listed. To make finding an enterprise easier, the selection can be 
narrowed using the Selection Filter. 

 

 
 

3. Select the year and/or commodity of the enterprise in the drop down lists. 
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4. Farm and Field can also be selected 
by pressing the Select Farm/Field 
button and choosing which field to 
filter by. 
 

5. Press the  button. 
 

6. In the Enterprise Properties box that 
appears, the Enterprise will be 
listed along with the Area and Plant 
and Harvest Dates. 

 
7. Make any modifications here and 

press OK. 
 

8. An enterprise can also be deleted 

here by pressing the  
button.  An enterprise cannot be 
deleted if any jobs are assigned to it. 
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Importing and Exporting Jobs   

Importing and Exporting Jobs 
Once jobs are created, there may be a need to import and export them for different uses outside 
of the office or on another device. Jobs can be exported in several useful formats such as .csv 
files, ArcView Shape files, FODM (.xml) files, and also for use with Trac Mate. Exporting a job 
will not remove or change it in the Jobs list. 
 

Marking Jobs for Export to Trac Mate 
 
You can export planned jobs from Farm Trac for use with the Trac Mate program out in the 
field. Trac Mate can be used on a handheld computer, such as an HP iPAQ, or the Titan RT.  
After you synchronize with Trac Mate, you can open and complete any exported jobs in Trac 
Mate while you are in the field. Completed jobs cannot be marked for export to Trac Mate. 
  
Exporting planned jobs from Farm Trac to Trac Mate is a three-step process:  First, you create 
the planned jobs with Farm Trac.  Second, you mark the planned jobs for export.  Third, you 
synchronize Farm Trac with a handheld computer or a USB drive.  You can read about creating 
planned jobs and synchronizing with Trac Mate in other sections of this reference guide. 
 
To mark a planned job(s) for export to Trac Mate: 
 

1. Locate the planned job(s) under the  tab. 
 

• Planned jobs have orange text and a clipboard with no checkmark.  
 

• Filters and sorting can be used to assist in finding the jobs (see Using the Jobs Tab 
section). 

 
2. Select and highlight the jobs to export. Several jobs can be selected by holding down the 

Ctrl key while selecting each operation. 
 

3. Mark the jobs for export by right-clicking one of the highlighted jobs, pointing to Work 
Order on the shortcut menu, and selecting Trac Mate. 
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4. Farm Trac adds the export icon  to the row of each planned job you chose in the Jobs 
box to let you know they are now marked for export to Trac Mate.  After you synchronize 
with Trac Mate, Farm Trac removes the icons from the jobs it copies to your handheld 
computer or USB drive.  You can mark a job for export and synchronize with Trac Mate 
as many times as needed. 

 

 
 

Synchronizing with Trac Mate 
 
If Trac Mate is installed on a handheld computer or the Titan RT, you can easily copy jobs 
completed in the field to Farm Trac running on your office computer.  Planned jobs created in 
Farm Trac can also be copied to Trac Mate for use as a work order in the field. The Synchronize 
Trac Mate feature of Farm Trac copies files to and from a handheld computer or to a USB drive 
for use with a Titan RT. If you are synchronizing with a handheld computer, you must first 
connect the handheld computer to your office computer and have the Microsoft ActiveSync 
program connect and synchronize with the device.  If you are synchronizing with a USB drive, 
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insert the drive into a USB port on your office computer and use My Computer or Windows 
Explorer to determine the drive letter Windows assigns to the USB drive. 
 
To synchronize Farm Trac with a handheld computer or USB drive: 
 

1. Connect your handheld computer to 
your office computer and 
synchronize with Microsoft 
ActiveSync according to the 
directions provided by the 
manufacturer. 

 
- or - 
 
Insert the USB drive into a USB port 
on your office computer. 
 

2. Select Synchronize Trac Mate on 
the File menu of Farm Trac, or select 
the Synchronize toolbar button.   

 

 

 
3. In the Trac Mate Options dialog box that opens, select CE Device if you are 

synchronizing with a handheld computer or Local Drive if you are synchronizing with a 
USB drive. 

 
4. Under Location, select the location where the Trac Mate jobs have been/will be saved to: 

 
• Select CE Main Memory to utilize the main memory of the connected handheld 

computer. (This is volatile memory that can be lost if the handheld computer’s 
battery discharges.) 

 
• Select CE SD Card to utilize the removable storage card of the connected 

handheld computer. If this option is available, it is suggested over using the Main 
Memory. 

 
• Select the drive letter for the USB drive to utilize the removable drive for use with 

the Titan RT. 
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5. Select Preview Job Details Before Recording if you want to view the details of the Trac 
Mate job and make any necessary changes before importing a job from Trac Mate. 
(Suggested) 

 
6. If Farm Site and Site Mate are being used, Upload Field Boundaries can be selected to 

copy boundaries from Farm Site for use in Site Mate in the field. 
 

7. If you selected Preview Job Details Before Recording, the Farming dialog box will 
display each job being synchronized. 

 
• Verify the accuracy and completeness of the information in the Farming dialog 

box. 
 

• Make any necessary modifications and select OK. Jobs will also be able to be 
edited within Farm Trac at any time. 

 
8. Once you select OK after the synchronization is complete, the jobs that were completed 

in Trac Mate will display in the  tab with black text and will have a clipboard 
with a checkmark next to them.  Planned jobs that were marked for export will also be 
exported to the handheld or USB drive for use within Trac Mate as work orders. 

 

Linking Resources when Synchronizing or Importing Jobs 
 
When importing jobs from either a file or from Trac Mate, there are times that there will be 
resources and job entry items used that are not entered into Farm Trac.  These can be created 
elsewhere and then set up in Farm Trac when importing. Many times, when entering a resource 
in the field, a different name may be used than what was used in the office. For this reason, the 
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Linker dialog box shows when importing jobs to either create new resources or “link” them with 
current ones. If they are linked, Farm Trac will assume that the two different items are actually 
one. 
 

1. When importing a job or synchronizing jobs from Trac Mate, the Linker dialog box may 
appear. Two lists of resources will be listed: Operation and Desktop. If there are items 
in the Operation box, they have to be either created or linked with the Desktop 
Resources. 

 

 
 

2. Select an item in the Operation Resources box. 
 

3. If it is a new item, press the  button. Enter all of the applicable information in 
the screen that appears about that item. This will create a new resource in Farm Trac. 

 
4. If the item is the same as an item already listed under Desktop Resources, highlight both 

resources and select the  button. 
 

5. If the Resource does not show up under the Desktop Resources, it may be a retired item. 
Place a checkmark beside Show Retired and it should now show in the list. 

 
6. Once all items are linked or created, press OK. 

 

Exporting Jobs 
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You can export planned and completed jobs from Farm Trac and save them on your computer or 
removable media such as a USB drive.  The file formats in which you can save the exported jobs 
include Comma Separated Value (.csv), FODM (.xml), and ArcView Shape (.shp, .shx and .dbf) 
files. You can only export one job at a time, and jobs you export will remain unchanged in the 
Jobs box of Farm Trac. 
 
After exporting jobs, you can import them into Farm Trac or another compatible program.  For 
example, FODM files can be imported into Farm Trac on another computer. Comma Separated 
Value (.csv) files can be exported and opened with a spreadsheet program, such Microsoft Excel. 
The details of the job can then be viewed, emailed, or printed. 
 
Exporting jobs is not the same as marking them for export to Trac Mate. See the appropriate 
section of this manual for those instructions. 
 
To export an operation: 
 

1. Locate and select the farming operation under the  tab. Filters and sorting can 
be used to assist in finding the correct operation (see Using the Jobs Tab section). 

 
2. Verify the operation is the one that needs to be exported by right clicking on the job and 

selecting Properties on the shortcut menu. This will display all of the entered 
information about the operation. 

 
3. To export the job, right-click on it in the Jobs box and select Export on the shortcut 

menu or it and select the  button at the bottom of the screen. 
 

 
 

4. The Job Export dialog box will then open. 
 

• Select the location to save the operation to. (My Documents, a USB Drive, etc.) 
 

• Enter a name for the job in the File Name box. 
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• Select the type of file to export the job to in the Save as Type list. (choose 
ArcView Shape File (*.shp), Comma Separated Values File (*.csv), or FODM 
XML File (*.xml) as the file type) 

 
• Select Save to complete the export. 

 
Farm Trac saves the exported job to the folder or removable drive chosen.  You can use 
Windows Explorer or My Computer to locate the file to copy it to a removable drive, attach it to 
an e-mail, or import it back into Farm Trac. To open a Comma Separated Value file with your 
computer’s spreadsheet program, (such as Microsoft Excel) right-click the file, point to Open 
With on the shortcut menu, and select the program to use to view the file.  For instructions on 
importing an FODM file back into Farm Trac, see the appropriate section in this chapter. 
 

Importing Jobs 
 
You can import planned and completed jobs into Farm Trac that were previously exported from 
the program.  Farm Trac imports operations using the FODM (.xml) file format.  You can only 
import one job at a time into Farm Trac. The imported job will be added to the Jobs box of the 
program where you can view, edit, print or export the operation. 
 
Importing jobs is not the same as synchronizing with Trac Mate. See the appropriate section of 
this manual for those instructions. 
 
To import an operation: 
 

1. Select Read Job Data on the File 
menu. 

 
- or - 
 
Select the Read Job Data button on 
the Job/Resource Tools toolbar.  

 
 

 
 

2. In the Read Job Data dialog box, select FODM XML under Generic Import. 
 

3. Locate the file to import by pressing the  button and select OK. 
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4. If there resources used in the operation that are not currently in Farm Trac, the Linker 
dialog box will appear. Create new resources or link them to already added items within 
Farm Trac. For more information, see the appropriate section. 

 
5. Farm Trac will add the imported job to the Jobs box and list it among all of the other 

planned and completed jobs where it can be viewed, exported, modified, or printed.
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Printing and Saving Reports     

Printing and Saving Reports 
Farm Trac offers many comprehensive reports that can be printed or saved. There are job reports 
that you can print as work orders to give to workers for use in the field.  There are equipment 
reports showing when your machinery is due for service, what fields the machines worked in, 
and the expenses accumulated for each machine. You can also print various field and supply 
reports showing the total costs as well as profit for each crop enterprise. 
 
Job reports are printed from the Jobs box, while other reports can be printed or saved from the 
Reports dialog box. The following formats can be used when saving a report: Microsoft Word 
documents, Microsoft Excel spreadsheets, and Adobe Acrobat Reader Portable Document 
Format (PDF) documents. 
 

Printing and Saving Job Reports 
 
You can print or save job reports for planned and completed jobs.  The job report for a planned 
job is a work order to give employees assigned to a job.  The job report for a completed job is a 
summary of the details of the farming operation that has been completed.  Only one job report 
can be printed at a time. 
 
To print or save a job report: 
 

1. Locate and select the farming operation under the  tab. Filters and sorting can 
be used to assist in finding the correct operation (see Using the Jobs Tab section). 

 
2. Right-click the job in the Jobs box, and select Print on the shortcut menu or highlight the 

job and select the  button at the bottom of the screen. 
 

 
 

3. A print preview screen will open where you can print or export the job report. 



Farm Trac Reference Guide 

117 

 
4. To choose a printer to which to print the report, or change the printer properties, select 

the Printer Setup toolbar button.  
 

 
 

5. Select the Print button  on the toolbar at the top of the window to print the report. 
 

 
 

6. In the Print dialog box that appears, you can choose the pages and number of copies to 
print. 
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7. To save a copy of the report: 
 

• Select the Export toolbar button.   
 

• In the Export dialog box that appears, choose the type of file you want to save the 
report as. 
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• In the Export Options 
dialog box, select the 
pages of the report to 
export or press OK to 
export the whole report. 

 
 

• In the Choose Export File dialog box, select the folder or removable drive where 
you want to save the report and enter a name for the file in the File Name box. 

 
• Farm Trac will then export the report to the specified location where it can be 

printed, copied, or emailed. 
 

Printing and Saving Field, Equipment, and Supply Usage Reports 
 
Farm Trac will print and save reports for all of your machinery, field enterprises, and supply 
usage. There are many different reports that can be printed. A few of the available reports are: 
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• Equipment reports: Enterprise Statement, Fleet Management, Notation Report, 
Usage Reports (Averages, Job Details, and Totals). 

 
• Field Reports:  Field Equipment Usage, Field Enterprise Statement, Planning 

Summary by Crop, and Planning Summary Total 
 

• Fertilizer and Supply Usage Reports 
 

• Personnel Reports 
 
To print or save a report: 
 

1. Select All Reports on the Reports 
menu, or select the All Reports 
toolbar button.  You can also right 
click on a piece of machinery or a 
person under the Inputs tab and 
select Reports to get an equipment 
or personnel report.  

 
2. Select OK to open the Report dialog 

box. The report type selected will be 
shown here. 

 
3. In the Reports dialog box, select 

exactly which report you want to 
print or save. Find the report by 
selecting the  beside each category 
to open the tree. 

 
 

4. Enter the dates to be shown in the report under Report Options. If the report is going to 
be printed, the Show Shading box can be unchecked to make it more clear and save ink. 

 

5. Place a checkmark beside each item that you want in the report The  and 

 buttons can also be used. 
 

6. When all of the options have been selected, press the  button to display the 
report for printing or saving. 
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7. The print preview window shows the first page of the report. Other pages can be viewed 
by selecting the Next Page button } and Previous Page toolbar buttons.  | 
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8. To choose a printer to which to print the report, or change the printer properties, select 
the Printer Setup toolbar button.  
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9. Select the Print button  on the toolbar at the top of the window to print the report. 
 

 
 

10. In the Print dialog box that appears, you can choose the pages and number of copies to 
print. 

 

 
 

11. To save a copy of the report: 
 

• Select the Export toolbar button.   
 

• In the Export dialog box that appears, choose the type of file you want to save the 
report as. 
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• In the Export Options dialog box, select the pages of the report to export or press 
OK to export the whole report. 
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• In the Choose Export File dialog box, select the folder or removable drive where 
you want to save the report and enter a name for the file in the File Name box. 

 
• Farm Trac will then export the report to the specified location where it can be 

opened, printed, copied, or emailed. 
 

• An equipment report example was used here. Follow the previous steps to print 
any additional report. 
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